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1. Introduction
Proloquo2Go was designed from the ground up for use on iPhone, iPod touch, and iPad, 
providing an easy to use, portable and affordable communication solution for people with 
difficulty speaking. A user can use it on an iPad at home, at work or at school and use it on 
an iPod touch or iPhone when going to the movies, a restaurant or hiking. Check out chapter 
8 on backup and restore to see how you can transfer a vocabulary from one device to 
another.

This manual covers all the features and explains how they can be used. There are three 
chapters you should definitely not skip. Chapters 6 and 7 will guide you through one of the 
best approaches to customize Proloquo2Go, and chapter 8 describes backup and restore 
features, helping you ensure you do not lose your modifications to the vocabulary in case 
Proloquo2Go gets accidentally deleted from the device.

The screen shots included in the manual are from the iPhone, but the screens look quite 
similar on the iPad. The main difference between using Proloquo2Go on the iPad versus the 
iPhone and iPod touch is that because of the larger screen the iPad can fit more buttons at 
once and also has a larger message window. The other important difference is that the 
Options will appear in a popover window on the iPad, while they are full-screen on the 
iPhone and iPod touch.
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2. Basic Use
Proloquo2Go is very easy to use. This chapter introduces basic navigation as well as the 
different communication views.

Proloquo2Go is pronounced:
"Pro" as in professional, “lo” as in low to the ground, “quo” as in quotation, the 
number “2” and “Go” as in on the go. Proloquo2Go. Proloquo is Latin for “speak out 
loud”.

2.1. Getting Started

The Startup Wizard

When you first launch Proloquo2Go, a startup wizard will 
appear that allows you to create a user and select a 
vocabulary for the user. Proloquo2Go allows you to choose 
between a Basic Communication vocabulary for beginning 
communicators, a Core Word vocabulary for more advanced 
communicators, or. a blank vocabulary.

If you are upgrading from a 1.x version of Proloquo2Go, you 
can select your current 1.x vocabulary. or you can start with 
Core Word, Basic Communication, or Blank. Whether you 
choose one of the new vocabularies or your 1.x vocabulary, 
your 1.x vocabulary will be saved inside of Proloquo2Go. 
You can back up your 1.x vocabulary to your computer, and 
you can also use it to create a 3.0 user at a later time. See 
chapter 8 for details. If you are upgrading from a 2.x version 
of Proloquo2Go, your vocabulary will automatically be 
upgraded to 3.0.

The Vocabularies

Core Word is for users who can put words together into 
sentences. It consists of a main page with the most 
frequently used words in English conversation, and folders 
of less frequently used words, organized in categories. Core 
Word can be configured from 9 to 64 buttons per page, and 
is optimized for quick sentence creation and language 
development.

Basic Communication is for users who are at the early 
requesting stage of language development, and usually 
have not started to combine words to form longer 
messages. Basic Communication can be configured from 9 
to 36 buttons per page, and provides support for developing 
requesting, commenting, early social interactions, and basic 
academics.

Note that if you later want to use another vocabulary you 
can always go to Options and create a new user. More 
details on creating a user can be found in section 3.1 
(Options View - User Options). More information on the 
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vocabularies and deciding which one to use can be found in chapter 6.

2.2. Speaking and Navigation

Home Screen

Press any button to let Proloquo2Go speak that button. To 
navigate to other categories press one of the folder-style 
buttons. Depending on the options that are currently set, the 
label of the folder-style button will be spoken.

Q: Can I change this default organization? 

Yes, certainly. Proloquo2Go is meant for you to fully 
customize. This manual and other support materials will help 
you learn to do that easily and efficiently. Donʼt forget to 
back up your vocabulary regularly (see chapter 8). 

Message Window

Press the Message Window at the top of the display to 
speak the currently displayed message. If the message is 
too long to fit you can scroll it by sliding it with your finger. To 
delete a single symbol in the Message Window press the 
Backspace button on the right side of the Message Window. 
To clear the whole message double tap the delete button.

To go back one level tap the Back button on the left side of 
the navigation bar. To go back to the Home screen from any 
level just tap the image and title shown in the navigation bar.

Q: Why does the message window auto clear? 

Auto-clear is a default option that can be toggled ON or OFF 
in the Interaction section of Options (see section 3.1). Auto-
clear means that after you have built a sentence and tapped 
the Message Window the text will be spoken but remain in 
the Message Window in case you want to repeat it by 
tapping again, or want to add it to your vocabulary by hitting 
the plus button. However, as soon as you tap another 
button, the Message Window will clear automatically.
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2.3. Views

We have already seen the Grid View in the images above. Here is the complete overview of 
views.

   

Grid View

This is the default view 
when Proloquo2Go is used 
for the first time. In the 
Proloquo2Go Options view, 
you can control the number 
of buttons shown, all the 
way from 1 to 144 per 
page. (Though in general 
we do not recommend 
using that many buttons. 
For most people the default 
4 x 4 grid with 16 buttons 
works well on iPhone or 
iPod touch. On the iPad 6 x 
6 to 8 x 8 are 
recommended.)

List View

In the Proloquo2Go Options view, you can toggle between 
the Grid View and the List View. Most users will want to use 
the default Grid View, but for those who prefer the List View 
is available as an option.
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Recents View

Using the toolbar at the 
bottom you can switch to 
Recents View. Recents View 
gives quick access to any 
sentence that was pressed 
in the Message Window or 
spoken in the Typing View 
some time during the last 
week. Recent messages are 
divided into those used 
during the last 15 minutes, 
the last hour, earlier today, 
yesterday, day before 
yesterday and earlier than 
that. Tap any of these 
buttons and you will get a 
detailed list of all the 
messages in the selected 
time interval. If there are 
many messages scroll up 
and down by sliding with 
your finger. Tap a message 
to speak it. Tap the green 
plus button to add the 
message permanently to 
your vocabulary.

Typing View

Using the Views button at the left end of the toolbar, you can 
switch to Typing View. In Typing view you can use the 
standard iOS keyboard to type a longer message. Using the 
toolbar at the top you can tap the Views button to switch to 
another view, Clear to clear the current text, Insert to insert 
the typed text to the Message Window, or Speak to just 
speak the typed text without inserting it.

If Prediction is turned ON in Options (see section 3.1) you 
will also see a number of suggested words or word 
combinations.

Note that if you want a larger keyboard you can rotate the 
device to get a landscape sized keyboard. On the iPhone 
and iPod touch word prediction is not available in landscape 
mode because there is not enough space on the screen.

If you would like to use the British, rather than the American 
prediction dictionary, exit Proloquo2Go and go to the 
Settings app. Go to General -> International and then 
change the Region Format to United Kingdom.
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Proloquo2Go Toolbar

Proloquo2Go has one toolbar. The top picture shows the 
toolbar for iPod Touch and iPhone. The toolbar button on the 
left end is used to switch between the major views: Grid/List, 
Recents, Typing and Options. The second button gives 
access to keyboard. The button on the far right side is used 
for editing. If you are away from the home screen, a home 
button appears in the toolbar. This button will take you to the 
home screen instantly. Note that depending on the 
restrictions set in Options not all buttons may be present in 
the toolbars (see section 3.1).

The toolbar for the iPad version is slightly different. Options 
is reached by the button on the far right side rather than 
through the Views button. The Edit button is to the left of the 
Options button.

2.4. Auto-Morphology

Auto-Morphology is a powerful feature that provides auto-conjugation for verbs and auto-
plurals and auto-possessives for nouns. It applies not just to the built in vocabulary elements 
but also works on user defined nouns and verbs.

Automatic conjugation

The Auto-conjugation feature can help you transform verbs 
quickly and powerfully. Press and hold on a verb is the 
default trigger, but in the Grammar section of the 
Proloquo2Go Options you can change this to double tap or 
use both triggers if you prefer (see section 3.1). You can 
also set the hold duration and double tap interval there.
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Automatic pluralization

The Auto-plural and auto-possessive feature makes working 
with nouns easy. Press and hold on a noun is the default 
trigger, but in the Grammar section of the Proloquo2Go 
Options you can change this to double tap or use both 
triggers if you prefer (see section 3.1). You can also set the 
hold duration and double tap interval there.

2.5. Quick Tips to Prevent Data Loss

Preventing Deletion of Proloquo2Go

By default, it is very easy to delete third party apps on iPad, iPhone, and iPod touch. You 
can delete an app holding on its icon until it begins to wiggle, tapping the "X" that appears 
above it, and tapping "Delete" in the dialog box that appears.

It is possible to prevent the deletion of apps. To activate this feature, go to the Settings app 
on your device's home screen, tap "General", scroll down, tap "Restrictions", tap "Enable 
Restrictions", create a four digit passcode and enter it again when prompted, and then 
toggle "Deleting Apps" to OFF.

We strongly recommend that you turn off the ability to delete apps to protect your 
Proloquo2Go customizations.

Preventing User Access to Proloquo2Go Options

Beginning users of Proloquo2Go may need to be prevented from accessing the Options 
views and editing features. Accidental changes to Proloquo2Go could cause loss of 
vocabulary modifications. You can set a password on the Options view, to allow access only 
to those who have been trained in how to modify the Options and perform editing functions. 
See sub-section “Password for Options View” in section 3.1 in of this manual.

Backing Up Proloquo2Go

It is very important to regularly back up the changes made to your copy of Proloquo2Go. If 
the device is lost or damaged, or if your customizations were unintentionally erased, you can 
restore your copy of Proloquo2Go from a back up. For detailed instructions, see Chapter 8.
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3. Options
Proloquo2Go has many options that allow a full customization to meet the needs of the user. 
There is no need to learn every option, but it is good to have a basic idea of what the 
customization potential is so that you can get most out of it. How to make best use of all the 
options to customize for an individual user is covered in chapters 6 and 7.

Note that Options control Proloquo2Goʼs appearance for every folder and button in the user. 
Some of these appearance characteristics can be over-ridden using options at the per-view 
and per-button level. See the table in section 4.4 for more information on how Options 
interacts with changes made at the view and button level.

3.1. Options View
On an iPod Touch or iPhone, the Options view can be accessed by tapping the Views 
toolbar button at the bottom left of the screen, and then tapping the Options button in the 
Views display. On the iPad, the Options button is the right-most button on the toolbar.
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The Options view provides access to a wide range of 
options. Options are divided into three groups: users, 
options specific to the current user, and general application 
options. The various option sections are described in more 
detail below.

Important Note: If you do not see the button for Options 
view, you will have to exit Proloquo2Go and go to the 
Settings app on your device's home screen to enable this 
button (see section 3.2).

You can get full-screen help for a specific options section by  
tapping the Help button when viewing or modifying that 
section.

Q: Can I use options from an earlier version of 
Proloquo2Go?

If you have an earlier version of Proloquo2Go installed on 
your device, you can use the options from there in 
Proloquo2Go 3.0. To do so, select Copy of Pre-2.0 Options 
in Startup Wizard or when creating a new user.

Users Options

In this section you can add a new user and switch between 
existing users.

Tap the name of the user you want to switch to, or tap Add 
User to create a new user. In the Add User view, tap in the 
User Name field and then type a name for the new user. Tap 
the Options row to choose whether you want the new user 
to have the same speech, appearance, and other personal 
settings as one of the existing users or to have the default 
settings. The Vocabulary settings allow you to select a 
vocabulary for the user. This can be one of the default 
Proloquo2Go vocabularies or a copy of another userʼs 
vocabulary.
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Appearance Options

Using the Appearance options, you can customize how your 
display looks. 

The Message Window section lets you define whether or not 
to display the Message Window and change its size. Tap the 
Advanced Options row to change the coloring scheme of the 
Message Window, have text appear below the images or 
above the images, and show or hide images in the Message 
Window.

Use the Toolbars section to change the size of the toolbar if 
you would like to have large buttons at the bottom, or, for 
example, a larger Back button in the navigation bar. You can 
also choose whether to display the current folderʼs icon in 
the toolbar or not.

In the View section, you can switch between List and Grid 
View, and specify the number of columns and rows in the 
Grid. The size of the buttons is adjusted automatically. This 
section also lets you choose the grid background color and 
button spacing - from Very Compact to Very Loose. Note 
that if you change the number of columns in Options in 
some folders the number of columns may not change 
because these folders were designed for a specific number 
of columns (see chapter 5 for more information). 

In the Buttons section, you can set up the appearance of 
Regular Buttons, Action Buttons, and Folder Buttons.

Choose to show only images, only labels, or both images 
and labels on the buttons. You can also change the screen, 
text, text background, and button background color and turn 
color-coding for the buttons on or off. Color coding is based 
on the word type.

For text display there are two settings. You can have text 
appear below the images or above the images. You can also 
let Proloquo2Go use two lines of text for a vocabulary 
element when the text is too long to fit on a single line.

Most properties can be set independently for each button 
type, though all buttons use the Regular Buttons settings 
until you open the Advanced Options in the Buttons group 
and turn the Same as Regular option off for Folder Buttons 
or Action Buttons. See section 4.4 for more information on 
how setting button appearance properties in Options and on 
a per-view or per-button basis interact.

Use the Typing View section to adjust font, size, and color of 
the text in the Typing View.

16



Speech Options

In this part of Options, you can choose a voice to use and 
customize it with Voice Personalization, create 
Pronunciation exceptions, and import pronunciations from 
other users. You can set speech characteristics such as 
volume and speech rate. 

Two more speech options allow you to determine when 
Proloquo2Go will speak.

If you only want Proloquo2Go to speak when you are done 
building a sentence and tap the Message window you 
should tap Speak Buttons and then pick None. If you pick All 
Buttons, even buttons that are purely for navigation and not 
part of the actual sentence you want to build will speak 
when tapped. This serves as a confirmation of the userʼs 
choice. If you prefer to only have Proloquo2Go speak for 
buttons that are part of the sentence construction, pick the 
Message Buttons option.

The last option lets you adjust how Proloquo2Go speaks in 
the Keyboard View. Tap Speak As You Type, and then select 
whether you want each letter, word, sentence, or paragraph 
to be spoken as you type it.

Download Voices

Additional voices can be downloaded when your device is 
connected to the internet. In the Speech part of Options, tap 
the Voice row.

Tap the speaker icon for a voice to hear what it sounds like, 
and the voice name to download the voice. Voice downloads 
will continue in the background if you leave the Voice view. 
You can download multiple voices at once, and pause, 
cancel, or resume downloads.

Voices that have been downloaded are displayed in the 
Voice view under Installed Voices. To switch to a 
downloaded voice, go to the Speech section of the Options 
and then pick Voice to choose the voice you want.

Q: How can I remove a downloaded voice?

First be sure you choose another Voice in the Speech 
section of Options, as the currently used voice can never be 
deleted. Next, you go to the Voice view and tap the Edit 
button. Now you will be able to delete the downloaded voice.
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Access Method

Use these options to help persons with special physical 
needs use Proloquo2Go more efficiently. Set up the Direct 
Access for users who can tap buttons directly on the screen 
and only need little assistance with filtering brief touches or 
may touch the screen in more than one place at the same 
time. Use the Switch Access for users who have to use 
external switches or just tap anywhere on the screen to 
activate an item currently being scanned. See the Access 
Methods chapter.

Interaction Options

With Auto-clear Message ON, Proloquo2Go will 
automatically clear the Message Window the next time you 
tap a button after the text in the Message Window was 
spoken. This is the default setting and means that after you 
have built a sentence and tapped the Message Window the 
text will be spoken but remain in the Message Window in 
case you want to repeat it by tapping again or want to add it 
to your vocabulary by hitting the plus button. Yet, when you 
now start constructing a new sentence the Message 
Window will clear automatically.

The Repeated Tap option determines what Proloquo2Go will 
do when the message window is tapped while the text is 
being spoken. Such taps can be ignored, restart speech, 
stop speech, or used to pause and then on next tap 
continue speech.

Repeat Delay (available separately for Message Window 
and buttons) can be used to prevent the user from 
repeatedly triggering the same utterance. During a user 
selectable repeat delay, taps on the Message Window and/
or buttons will be ignored.

Use the Keyboard Button option to define whether to go to 
the Grid Keyboard folder or the Typing View when you tap 
the Keyboard button on the Toolbar.
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You can have Proloquo2Go Scroll by Page instead of 
incrementally. For some users this will work better. Select 
Show Paging Buttons if you want Proloquo2Go to provide 
Page Up and Page Down buttons to navigate up and down 
instead of using the swipe gesture. Select Single Page 
Swipe to scroll pages one by one with the swipe gesture.

Tap Advanced Options and specify whether you want the 
Home button and the Previous button appear on each page. 
You can also turn visual transition effects on and off.

The Allow Repeat option can be used to prevent repeated 
tapping of a single button.  When Allow Repeat is turned off, 
once a user has tapped a button, that same button cannot 
be activated until a different button has been tapped.  

You can set which orientations you would like Proloquo2Go 
to support. Full allows all orientations, Portrait up & down 
allows regular portrait and upside down portrait views and 
Portrait up prevents all rotation and forces Proloquo2Go in 
the default portrait orientation.

Grammar Options

You can turn the automatic conjugation and pluralization 
feature off by turning grammar support OFF.

You can determine what trigger will be used to activate the 
grammar features and what the timing should be for that 
trigger. Note that if you choose double tap as a trigger, the 
longer the double tap interval is the longer all interaction will 
take because Proloquo2Go will have to wait and see if there 
is going to be a second tap before it undertakes any further 
action on the initial tap.

If you turn Advanced Grammar OFF, fewer conjugations will 
be shown and noun possessives will not be displayed.
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Prediction Options

You can turn prediction OFF if you do not want to have word 
prediction in Typing View.

You can turn Auto-spacing OFF if you do not want the 
prediction system to automatically insert a space when 
tapping a suggestion or automatically add/remove spaces in 
response to punctuation.

For Learning there are two options. You can turn Learning 
OFF so that the word prediction system does not learn new 
words and word combinations. Turning this off will reduce 
the prediction efficiency. By default Learning is ON, but 
Learn Misspellings is OFF. This ensures that new words and 
word combinations are learned by the prediction system, but 
only those known to the built-in dictionary. This is especially 
useful if a user makes a lot of spelling mistakes and you do 
not want the prediction system to learn misspelled words. It 
is currently not possible to delete learned words from the 
userʼs word prediction dictionary.

You can let Proloquo2Go display as many suggestions as fit 
on the screen or limit the number of suggestions to a fixed 
number, say four or five.

By default Proloquo2Go provides multi-word prediction 
whereby sometimes sequences of multiple words (.e.g., “to 
go”) are suggested when those combinations seem highly 
likely.

Finally, you can change the size of the prediction buttons.
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Vocabulary Options

In Vocabulary, you can specify which folder will be used as 
the Home Page and temporarily switch to use the 
vocabulary Root as your home folder.

Restrictions Options

You can restrict access to the Edit mode and to Adding new 
buttons. For some users Adding buttons is fine, but you do 
not want them to accidentally delete buttons so you can 
disable Edit Mode for that purpose.

You can also block access to the Typing View and/or Recent 
View.

You can choose to have the keyboard button in the toolbar 
or hide it. 

You can restrict access to Restore from Backup.

Privacy Options

In this section, you can clear the contents of the Recents 
view to preserve the userʼs privacy.

Backup

You can backup or restore your Proloquo2Go 
customizations in the Backup section of Options. See 
Chapter 8 in this manual for detailed instructions.
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Password for Options View

When the Ask Password switch is ON, you must enter a 
password in order to see the Options view. This allows you 
to prevent the user from accessing editing and destructive 
functions without having to hide the Options button.

If you have set a password and then forget it, contact 
AssistiveWareʼs technical support at 
support@proloquo2go.com, and we will help you reset the 
password.
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3.2. Settings
Device Home Screen

To allow or restrict access to the Options described in 
section 3.1, you must go to the Settings app and locate the 
Proloquo2Go section in the list of app settings. Press the 
home button on your device to get to the home screen, and 
look for the Settings app (its icon is a set of gears.)

Inside Settings

In the Settings app you need to scroll down to get to the 
Proloquo2Go settings. Next, tap onto the Proloquo2Go row 
to access the Proloquo2Go settings.

Proloquo2Go Settings

There is only one option in the Proloquo2Go section of the 
Settings app - here you can control whether the Options 
view is accessible from within Proloquo2Go. Setting Show 
options button to OFF simplifies the Proloquo2Go interface 
and prevents accidental changes to the app.
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4. Adding and Editing Buttons
Adding new vocabulary buttons and editing existing vocabulary buttons can be done right on 
the iPhone, iPod touch or iPad. Adding and editing is extremely easy and does not require 
any special "programming" skills.

There are various ways in which you can add new buttons to your vocabulary. You can add 
from the Message Window, add from the Recents list and add in Edit mode. In the first two 
cases you are adding a message that has already been created. In the last case you create 
a completely new button that can hold any text you like.

Note that if you do not see the Add or Edit buttons these may have been turned off in the 
Restrictions section of the Proloquo2Go Options. See chapter 3 for more details.

4.1. Creating a button from an existing message

Adding the Current Message

To add the current text in the Message Window to your 
vocabulary simply navigate to the folder in which you would 
like to place the new button and then press the button  on 
the right side of the navigation bar.

Tap “Add Button”  . 
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Adding a Recent Message

To add a recently used message, go to the Recents View by  
tapping on the Views button in the bottom toolbar, then 
tapping the Recent button to navigate to the message you 
would like to add. Press the green plus button to add the 
message to a button.

Q: How do I determine to which folder a recently used 
message should be added to?

Before going to Recents, you have to navigate in grid or list 
view to the folder you would like to add your new button to. 
The message will be added to this folder after you tap the 
plus button. 

When you add a button using either a recent message or 
the message currently in the message window, 
Proloquo2Go makes some suggestions for what the button 
will look like. The Text to Speak field contains the text that 
will be spoken when the button is tapped. The Label field 
contains the same text in gray letters. This indicates that 
unless you type a specific label the Text to Speak will also 
be used as the button label. You can tap either the Text to 
Speak or Label fields and a keyboard will appear. Use the 
keyboard to change the text - the Label and Text to Speak 
do not have to be the same.

Next, you need to decide what image you would like to use. 
Proloquo2Go gives you some suggestions for symbols 
based on the symbols and words in your message. These 
suggestions appear in a scrolling row below the text fields. 
To see more suggestions, tap the arrows at the ends of this 
row. To pick a suggestion, just tap it and the picture in the 
preview of your button will be replaced with your new 
choice. Or tap the preview of your button and youʼll be given 
the choice to search for a symbol, use an image from your 
photo library, or take a photo (if your device has a camera.)

You can also change the way your button looks by setting its 
background color, border color and width,text color and font, 
whether it displays its label or image, and whether it is 
visible, dimmed, or hidden. You can change how the button 
speaks its text using the Voice Properties section. These 
features will be explained below.
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4.2. Creating a new button

 

Switching to Edit Mode

To add a new button, you 
need to switch to Edit Mode. 
To switch to Edit Mode, tap 
the edit button  on the 
right side of the bottom 
toolbar (the pencil icon). A 
panel of editing tools will 
appear at the bottom of the 
screen. On the Arrange tab

, youʼll see a choice of 
three button types .

Button Types

Proloquo2Go gives you a choice of three types of buttons - Regular Buttons, Action Buttons, 
and Folder Buttons. 

Regular Buttons will speak text and insert text and symbols into the Message Window. Most 
of the buttons you will create will be Regular Buttons. See Creating a Regular Button section 
for how to add Regular buttons.

Action Buttons perform actions such as speaking a message immediately without putting it in 
the Message Window, speaking the message in the Message Window, or clearing the 
Message Window. See Creating an Action Button section for details on Action buttons.

Folder Buttons take you to another folder of buttons. A folder button has a different shape - 
the upper left corner of a folder button looks like the tab on a file folder. You can create a 
Folder Button to go to a folder that already exists, or you can create a new blank folder at 
the same time as you create your folder button. See Creating a Folder Button section for 
details on Folder buttons.
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Creating a Regular Button

Make sure the Arrange tab is selected, and tap the Add 
Regular Button icon.

Tap the Text to Speak field and enter the text you want the 
button to speak. As you type, Proloquo2Go will suggest 
symbols based on your text. It will also fill in the Label field 
to match the Text to Speak field. Note that the Label text is 
gray, which means that the Label will automatically change 
to whatever is in the Text to Speak field.

Proloquo2Go automatically selects a symbol for the button. 
To choose one of the other suggested symbols, tap its 
picture and the symbol in the button preview will be replaced 
with your choice. To see more suggestions, tap the arrows 
on the left and right end of the row of suggestions.

Tap the speech code button  to have the button play 
special sounds (see below).

To choose another image or to have no image on the button, 
tap the button preview. See Choosing a Button Image for 
information on choosing an image.

Special sounds come in three types: noises like whistling or 
coughing; common expressions like "Wow!" or "Boo!"; and 
macros. Macros are placeholders for information that may 
change with time — for example, the current date or the 
battery charge level in various formats. If the button is 
activated, the placeholder is replaced with the actual value, 
which is then spoken. 

Tap one of the tabs  at the top of the screen to view a list 
of sounds of the corresponding type.

To select a sound, tap its name. Tap the speaker icon to 
listen to the sound before selecting it.

Some sounds are not available in certain voices. These are 
marked with a special icon .
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If you would like the button to have a label that is different 
than the text the button will speak, tap in the Label field and 
type in your label. Note that the text color turns from gray to 
black, showing that the label is now different than the text to 
speak.

When youʼre done specifying the text fields, tap the Done 
button on the keyboard (bottom right of the screen.)

Now you can customize the appearance of your button. 
Weʼll cover the Word Kind feature here, and the other 
customization features will be covered in later sections.

Proloquo2Go can take advantage of knowing what part of 
speech a button contains in two ways. Your button can be 
automatically color coded by part of speech. You can also 
access the auto-conjugation features if your buttons that 
contain nouns and verbs have their word kind set 
accordingly.

Proloquo2Go will automatically set the Word Kind of your 
button when you finish typing in the text to speak and leave 
the text to speak field. To manually set a buttonʼs Word Kind, 
tap the Word Kind row, and youʼll see a list of choices. Tap 
the choice that matches the grammatical part of speech for 
your buttonʼs text and tap the back button in the upper left 
corner of the screen.

Note that your buttonʼs border has automatically been 
turned yellow, to show its word kind of “noun.”

You can further customize your button using the other rows 
in the Button Properties area. For example, starting in 3.0, 
you can set the voice that a button will use for its speech, 
including the voice speed, pitch, and other characteristics. 
Scroll down to the Voice Properties section to access this 
feature.

When youʼre finished, tap the Done button in the upper right 
corner of the screen to save your button.
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Creating an Action Button

Make sure the Arrange tab is selected, and tap the Add 
Action Button icon.

First, choose what action your button will perform by tapping 
the Action field.

Add Text to Message Window will add the buttonʼs Text to 
Speak and symbol to the Message Window, just as a regular 
button does.

Speak Text Immediately will speak the buttonʼs Text to 
Speak without adding it to the Message Window. This is 
useful for situations where you are composing a longer 
message and want to quickly communicate about something 
else.

Speak Message Window will speak the contents of the 
Message Window aloud. This is equivalent to tapping the 
message window to speak the message.

Clear Message Window will erase the contents of the 
Message Window. This is equivalent to double tapping the 
delete icon in the Message Window.
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If you select Speak Message Window or Clear Message 
Window, an appropriate symbol will automatically be 
selected for you. If select Speak Text Immediately or Add 
Text to Message Window, or if you would prefer another 
symbol, tap the button preview to choose an image. See 
Choosing a Button Image for information on choosing an 
image.

You can further customize your button using the other rows 
in the Button Properties area. When youʼre finished, tap the 
Done button in the upper right corner of the screen to save 
your button.

Creating a Folder Button

Make sure the Arrange tab is selected, and tap the Add 
Folder Button icon.

To create a new folder, choose New Folder. To create a 
button that takes the user to a folder that has already been 
created, choose Link to Existing Folder.
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Creating a new folder 

Tap the Folder text field and type the name of your new 
folder. As you type, Proloquo2Go will suggest symbols 
based on your text. It will also fill in the Label field to match 
the Folder field. 

Proloquo2Go automatically selects a symbol for the folder. 
To choose one of the other suggested symbols, tap its 
picture and the symbol in the button preview will be replaced 
with your choice. To see more suggestions, tap the arrows 
on the left and right end of the row of suggestions. If no 
arrows appear, there are no additional suggestions. 

To choose another image or to have no image on the button, 
tap the button preview. See Choosing a Button Image for 
information on choosing an image.

You can create a folder button that also adds text to the 
Message Window when the button is tapped, as well as 
displaying the new folder. This is useful for beginning 
communicators who need help creating sentences. To enter 
text here, tap the gray text field next to Text to Speak and 
type. If you donʼt specify any text to speak, the folder button 
will not put anything into the message window

You can give the folder button a label that is different from 
the folderʼs name. To do this, tap the gray text next to Label 
and type. If you donʼt specify a label, the name of the folder 
will be used. 

When youʼre done specifying the text fields, tap the Done 
button on the keyboard (bottom right of the screen.)

You can further customize your button using the other rows 
in the Button Properties area. When youʼre finished, tap the 
Done button in the upper right corner of the screen to save 
your button.
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Using an existing folder

Tap the Link to Folder row to search a list of the folders in 
your vocabulary to link to.

You can create a folder button that also adds text to the 
Message Window when the button is tapped, as well as 
displaying the new folder. To enter text here, tap the gray 
text field next to Text to Speak and type.

You can give the folder button a label that is different from 
the folderʼs name. To do this, tap the gray text next to Label 
and type. If you donʼt specify a label, the name of the folder 
will be used. When youʼre done specifying the text fields, tap 
the Done button on the keyboard (bottom right of the 
screen.)

When you return from selecting a folder, notice that the 
folderʼs image and name have been added to your button. 
To pick a different symbol for your button, tap the button 
preview.

Choosing a Button Image

If you would like to use different images than Proloquo2Go 
automatically suggests, you have several options. Tap the 
button preview and select from the following options:

• Delete Symbol: use this to create a button with no symbol

• Choose a Symbol: search Proloquo2Goʼs SymbolStix 
database for the symbol you want.

• Choose a Picture: choose an image from the photo library 
on your device.

• Take a Picture: if your device has a built in camera, you 
can use it to take a photo for your button.

32



Setting the Background or Border color of a button

When you tap the rows marked Background Color or Border 
Color, youʼll be given the choice of many different colors to 
use. Colors are organized into seven different palettes to 
provide a wide variety of looks as well as the ability to easily 
determine what color an existing button uses. This makes it 
easier to create buttons with the same colors.

Select any color you wish. You will see that the checkmark 
on the row Use Default Choice disappears, and youʼll be 
able to see the effect of your choice in the button preview 
when you leave the color chooser. To return to using the 
default color, tap the Use Default Choice row and the 
checkmark will return. Please see section 4.4 to understand 
how the concept of Default works.

Text Options

Tap the Color row to change the color of the text displayed 
on the button. Select any color you wish. To return to using 
the default color, tap the Use Default Choice row and the 
checkmark will return. Please see section 4.4 to understand 
how the concept of Default works.

Tap the Font row to change the font settings that are used 
for the button label.

Border Width Options

You can define the width of the border shown around the 
button. To do so, tap the Border Width row and then pick an 
option you like. Tap Default to use default settings.

33



Button Display Options

You can customize whether an individual button displays its 
image and/or label by tapping the Display row in Button 
Properties. Tap a selection and return to see the effects of 
your choice in the button preview. You can always return to 
using the Default settings for this user by selecting the 
Default row.

Button Visibility

A Proloquo2Go button has three possible visibility states. 
The second image shows the three states in edit mode, and 
the third image shows the states in use mode.

• Normal: the button can be seen and does what it is 
programmed to do when tapped.

• Dimmed: the button can be seen, but is dimmed, and 
cannot be tapped. Useful for choices that are not currently 
available.

• Hidden: the button canʼt be seen except in edit mode. It 
will leave a gap in the display when not in edit mode. 
Useful for hiding vocabulary the user is not ready to have 
access to, while maintaining a consistent folder layout.

Button Voice

Voice characteristics may differ from button to button. Use 
the Voice Properties section in the buttonʼs Properties view 
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Editing an existing button

To edit an existing you first need to switch to Edit Mode. To switch to Edit Mode tap the edit 
button on the right side of the bottom toolbar. In both grid and list view you will see that the 
appearance of the grid or list changes when you enter the Edit Mode.

  

Accessing the Button 
Properties

Once you are in Edit Mode, 
tap on the button you want to 
change. A small blue 
checkmark will appear on the 
button. Then tap on the 
Properties tab  to access 
the properties you can 
change. To see more of the 
properties area, tap the 
expansion button  to allow 
the editing tool panel to take 
up more of the screen.

Now you have access to all the same properties you used to 
create buttons. See the section about creating new buttons 
for details. 

You donʼt have to select Done when youʼre finished with 
your changes to the currently selected button. To edit a 
different button, tap on the current button to deselect it, and 
tap on the button you want to edit. The new buttonʼs 
information will now appear in the Properties tab. If you want 
to move the editing panel down so that you can see more 
buttons on the screen, tap the expansion button , and the 
editing panel will slide towards the bottom of the screen.
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4.3. Editing multiple buttons at once

You can select multiple buttons on the screen and edit their 
properties at the same time. When more than one button is 
selected, each button will have a checkmark, and youʼll see 
the properties you can edit in the properties tab.

4.4. Multi-level options: Making effective use of appearance defaults

Proloquo2Go 2 provides a wide range of options that allow users to control the appearance 
of folders and buttons in detail. To make it really easy to customize the appearance for 
individual needs, many options can be set at multiple levels depending on the effect that the 
user wants to achieve. By changing an option to a specific setting at one level and to 
“default” at others, pinpoint control can be achieved, while it will still be easy to change the 
appearance of many buttons at once. This section explains how the process works and how 
you can make best use of the appearance customization options of Proloquo2Go.

Options can be customized at user level, at folder level, and at button level. Any setting that 
is customized at user level (in Options) applies to all folders and buttons of the vocabulary 
apart from those for which this setting is defined at folder or button level. This means that if, 
for example, you want all buttons to show only text, without any images, you should go to 
the Appearance section of Options and set the Display option in the Buttons group to Label 
Only. Once you make this change, all buttons in the userʼs vocabulary will only display text. 
As the Appearance Options are user-specific, this will not affect the vocabularies of other 
users.

Now imagine that you have a folder in which you did not use symbols on the buttons, but 
used photos of your friends instead. It would be a pity not to show those photos on the 
buttons. So, to have images on those particular buttons, you simply navigate to the folder 
containing the buttons. Once in the folder, you tap the pencil button to enter Edit mode. In 
Edit mode you tap the Folder tab and either expand the edit area with the expand button or 
swipe down to Button Display. Tap the Button Display row. You will see that it is currently set 
to Default. Default means that the folder will display buttons the way that is defined at user 
level. Tap the Image and Label row, and the images will magically appear on all the buttons. 
If you leave Edit mode and navigate around a bit in the vocabulary, you will see that this 
change only applies to this distinct folder. To be even more specific, it only applies to the 
view for which you made the change, so if you had buttons at the secondary priority level of 
the folder, they will not be affected by changes at primary level. This allows you to show the 
primary level in one style and the secondary level in another.
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Now imagine that you do not want to show images on all the buttons in the folder that 
contains buttons with photos of your friends, perhaps because one or two of your friends are 
not happy with how their pictures look. Open the folder that contains the buttons with 
pictures of your friends, and then tap the pencil button to enter Edit Mode. Now select the 
button or buttons for which you do not want to display an image. Then tap the Properties Tab 
and either expand the edit area with the expand button or swipe down until you see the 
Display group. You will see that it is currently set to Default. Default means that the button 
will be displayed the way that has been defined for the View or, if the option at folder level 
was set to Default, the way it was set at user level (in Options). Now tap the Display row and 
select Label Only. You will see that the selected button or buttons now show only a label, 
without any pictures.

Note that if you later wanted a folder or a button to be displayed with the default options as 
set at user level, you should set them to Default for the folder or button. This is important if, 
for example, you have changed the background color. Say that at user level you have set 
the Button background color to white, for a certain button it was set to yellow, and now you 
want to make that button white again. In this case, you should not change the background 
color of the button to white; you should set it to Default instead. The reason for this is that if 
you later want to set the background color of all buttons to gray, which you would do in user-
level Options, this specific button would remain white, because its background color was set 
to white instead of Default.
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The following tables summarize how each appearance and voice characteristic can be 
controlled at User, View, and/or Button level for buttons and views.

Regular Button 
Property

User Level Folder Level Button Level

Custom border color Appearance > 
Buttons Advanced 
Options

N/A Arrange or 
Properties tab of 
edit tools

Language-based 
color coding for 
border

Appearance > 
Buttons Advanced 
Options

N/A N/A

Custom background 
color

Appearance Folder tab of edit 
tools

Arrange or 
Properties tab of 
edit tools

Language-based 
color coding for 
background

Appearance > 
Buttons Advanced 
Options

N/A N/A

Label color Appearance > 
Buttons Advanced 
Options

N/A N/A

Label position Appearance N/A N/A

Lines per label Appearance N/A N/A

Display label and/or 
images

Appearance Folder tab of edit 
tools

N/A

Visibility N/A N/A Arrange or 
Properties tab of 
edit tools

Voice Properties Speech Folder tab of edit 
tools

Arrange or 
Properties tab of 
edit tools

Folder Button 
Property

User Level Folder Level Button Level

Custom border color Appearance > 
Buttons Advanced 
Options

N/A Arrange or 
Properties tab of 
edit tools

Language-based 
color coding for 
border

N/A N/A N/A
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Folder Button 
Property

User Level Folder Level Button Level

Custom background 
color

Appearance > 
Buttons Advanced 
Options

N/A Arrange or 
Properties tab of 
edit tools

Language-based 
color coding for 
background

N/A N/A N/A

Label color Appearance > 
Buttons Advanced 
Options

N/A N/A

Label position Appearance 
(Regular, Folder, 
and Action buttons 
will all have same 
label position)

N/A N/A

Lines per label Appearance 
(Regular, Folder, 
and Action buttons 
will all have same 
lines per label)

N/A N/A

Display label and/or 
images

Appearance > 
Buttons Advanced 
Options

Folder tab of edit 
tools

N/A

Visibility N/A N/A Arrange or 
Properties tab of 
edit tools

Voice Properties Speech Folder tab of edit 
tools

Arrange or 
Properties tab of 
edit tools

Action Button 
Property

User Level Folder Level Button Level

Custom border color Appearance > 
Buttons Advanced 
Options

N/A Arrange or 
Properties tab of 
edit tools (N/A for 
Paging or More/
Back buttons)

Language-based 
color coding for 
border

N/A N/A N/A
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Action Button 
Property

User Level Folder Level Button Level

Custom background 
color

Appearance > 
Buttons Advanced 
Options

N/A Arrange or 
Properties tab of 
edit tools (N/A for 
Paging or More/
Back buttons)

Language-based 
color coding for 
background

N/A N/A N/A

Label color Appearance > 
Buttons Advanced 
Options

N/A N/A

Label position Appearance 
(Regular, Folder, 
and Action buttons 
will all have same 
label position)

N/A N/A

Lines per label Appearance 
(Regular, Folder, 
and Action buttons 
will all have same 
lines per label)

N/A N/A

Display label and/or 
images

Appearance > 
Buttons Advanced 
Options

Folder tab of edit 
tools

N/A

Visibility N/A N/A Arrange or 
Properties tab of 
edit tools (N/A for 
Paging or More/
Back buttons)

Voice Properties Speech Folder tab of edit 
tools

Arrange or 
Properties tab of 
edit tools
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Folder View 
Property

User Level Folder Level

Background color Appearance Folder tab of edit 
tools

Number of columns Appearance Folder tab of edit 
tools (see 
Understanding 
Folder Views, 
chapter 5)

Grid or List display 
style

Appearance Folder tab of edit 
tools

Button spacing Appearance > View 
Advanced Options

N/A

Voice Properties Speech Folder tab of edit 
tools
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4.5. Moving Buttons

Re-ordering in List View

To move a button in list mode, touch the gray lines at the 
right end of button's row and drag the row its new position.

Moving in Grid View

To move buttons, get into Edit mode by tapping the Edit 
button . 

There are three different ways to move buttons in Grid view.

•  Drag: Drag a button so it moves between two buttons, 
causing all buttons to shift on screen.

• Drag and Swap: Drag a button on top of another button, 
causing the buttons to switch positions without moving any 
other buttons.

• Swap: Select multiple buttons and use the Swap tool to 
cycle their positions without moving the non-selected 
buttons.

Below each of these methods are described in more detail.
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Moving Buttons with Drag to reflow
• Press and hold the button you want to move until it starts to pulse.
• Drag the button so it is over the buttons you want to move it in between. Let go of the 

button.
• The button will now be in between the two buttons, and all buttons will shift around to 

make room for this move.
In the example above, dragging the red button in between the blue and white buttons causes 
the white and green buttons to shift down to make room for the red button.

       

Moving Buttons with Drag to Swap
• Press and hold the button you want to move until it starts to pulse.
• Drag the button on top of the button you want to swap with. Let go of the button.
• The two buttons will be swapped, and no other buttons will move.
In the example above, dragging the red button on top of the white button causes the white 
and red buttons to change positions, while no other buttons move.
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Moving Buttons with the Swap Button

• Make sure the Arrange tab  is selected, so you can see the Swap button 
• Tap multiple buttons to select them. Each will have a blue checkmark.
• Tap the Swap button to cycle the buttons through each otherʼs positions.
In the example above, the first tap of the Swap button moved the blue button to the right to 
where the green button was, the green button down to where the red button was, and the 
red button down to where the yellow button was. The yellow button is moved up to where the 
blue button was. The second tap of the Swap button moved the yellow button to where the 
blue button was, the blue button to where the green button was, and the red button is moved 
up to where the yellow button was.
Note that the Swap button works best when only two buttons are selected. In that case, it 
acts the same as Drag to Swap, except you donʼt need to drag the button to do the 
swapping. 

The blue line  indicates the position of page breaks - points in the folder where the user 
will need to swipe in order to reach more buttons. It can be useful to have this information 
while moving buttons, in order to make sure related buttons are on the same “screenful” of 
buttons and to minimize the need for scrolling.

44



4.6. Copy, Paste, and Delete Buttons

Switching to Edit Mode

The first step is to enter Edit Mode. To switch to Edit Mode 
tap the edit button  on the right side of the toolbar. The 
toolbar will then slide up and present controls for arranging 
and editing buttons and editing views and the Done button 
for leaving edit mode. 

Copy buttons

Once you are in Edit Mode you simply tap on the buttons 
you want to copy one by one. Each time you tap on a 
button, a checkmark appears in its top-right corner. Make 
sure you have the Arrange tab  selected. When you have 
marked all the buttons you want to copy, tap Copy .

Navigate to Paste Location

You can do this using the back button in the navigation bar, 
by single tapping the More and Back buttons that navigate 
between priority levels, or by double tapping on any folder 
button.

Once you reach the folder you want to paste into, tap the 
Paste tool , and the buttons you copied will appear.

Starting in 2.0.1, you can copy and paste buttons between 
users. To copy buttons between users, copy the buttons as 
usual, go to Options and switch to the desired user. Go into 
edit mode, navigate to the desired fold, and paste the 
buttons.

Copying and pasting folder buttons is not supported in 3.0. 
You will get an error message if you try to do so. You can 
create folders in your new user to duplicate the folder 
structure you want to copy from your old user. Then in the 
old user, go to each folder in turn, copy all the non folder 
buttons, switch to your new user, and paste them into the 
corresponding folder in the new user. We will be supporting 
a more convenient way to do this in a future release. 

45



Buttons can also be deleted in Edit mode. Make sure you 
have the Arrange tab  selected. Then tap to select the 
buttons you would like to delete, and tap the Delete button 

.

Youʼll be asked whether you want to permanently delete the 
buttons or move them to storage. If a button is permanently 
deleted, it is completely removed from the vocabulary and 
cannot be retrieved later. See section 4.7 for more 
information about the Storage level of folders. In general, it 
is recommended to move a button to storage rather than 
delete it.

Here the buttons have been removed. Depending on the 
Element Order set for the folder, the buttons around the 
deleted buttons may move together to fill in gaps in the 
page.

4.7. VocaPriority™: Promoting and demoting buttons

Proloquo2Go provides a new way of organizing vocabulary called VocaPriority™. Folders or 
pages in a vocabulary organization typically contain many buttons with related words and 
phrases. Some words or phrases are used frequently, while other words or phrases may be 
very powerful, but are not needed very often. For example, on a page with verbs related to 
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feelings, the word “love” might be used many times a week, while the word “celebrate” may 
be used infrequently. While it is possible to create a folder of all the feeling-related verbs a 
person might need to say, this folder would quickly become difficult to use as it would 
become filled up with verbs that are not frequently needed. It would also be possible to 
create a folder with only those feeling verbs that are most frequently needed, but then the 
user would miss the opportunity to use less frequently needed verbs such as celebrate or 
bother. With VocaPriority™, frequently used words and phrases are placed in the primary 
priority level of a folder. Words that are still useful for the user on a less frequent basis are 
placed in the secondary priority level. These secondary buttons can be reached using a 
More button at the bottom right corner of the page. When on the secondary page, the 
primary page can be reached by a Back button at the bottom right corner of the page. These 
More and Back buttons are automatically generated by Proloquo2Go, so all the person 
customizing the vocabulary needs to do is mark buttons in a folder as primary or secondary, 
and Proloquo2Go will do the rest.

There is a third level of priority in VocaPriority™ - Storage. The Storage level is only 
available in Edit Mode and thus not exposed to the end-user. Storage is the place where you 
put related words and phrases that are very unlikely to be needed by the user at the 
moment, but which the user may need at a later time when his or her language skills have 
developed or life circumstances change. In the feeling verbs example, “divorce” and 
“protest” may be placed in storage as the userʼs current language level or life experiences 
make these words unlikely to be useful. But if a need arises to make these words available, 
they can be easily moved from storage to the secondary or primary level using “promotion”. 
Similarly, if the user is overwhelmed with the number of choices in primary or secondary 
levels, buttons can be moved to a lower level using “demotion.” In this case, the words can 
easily be restored when theyʼre needed. Proloquo2Goʼs Core Word vocabulary uses 
VocaPriority™ to create a vocabulary that is both linguistically rich and easily customized for 
different language levels and individual preferences. The screenshots below show the 
primary, secondary, and storage priority levels for the Feeling Verbs folder in Core Word.

Promoting or demoting a button from Primary or Secondary
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Tap the pencil icon in the toolbar to get into edit mode. Tap 
the button(s) youʼd like to promote or demote so that they 
become selected. Make sure the Arrange tab  is selected 
so you can see the priority level tools. Then tap the tool for 
the level you want to move the button(s) to - Primary , 
Secondary , or Storage .

Depending on the Element Order of your page, buttons may 
shift to fill in any gaps once the buttons you selected were 
promoted or demoted.

Promoting a button from Storage

Promoting a button from storage works same as promoting 
or demoting from another level, except that you need to use 
the priority level buttons to see the buttons on the Storage 
level. Enter Edit mode and tap the Storage icon  in the 
upper right corner of the screen. It looks like a file drawer
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You will now see the buttons in Storage. When theyʼre in 
Storage, buttons donʼt have appearance properties that can 
be customized, so they may look different from buttons on 
other levels. The buttons will get the default appearance 
settings of their folder when they are promoted out of 
storage.

Make sure the Arrange tab  is selected so you can see 
the priority level tools. Then tap the tool for the level you 
want to move the button(s) to - Primary  or Secondary 

.

You can return to the Primary or Secondary level by tapping 
the priority level  button 1 or 2.
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5. Adding and Editing Folder Views
5.1. Understanding Folder Views

In Proloquo2Go, a folder is a set of buttons. A folder view is a way to look at those buttons. 
With folder views, a folder can look different depending on what number of columns the user 
has selected. Here is an example from Core Word - three different views of the Breakfast 
folder: 

In the 5 column view, there is plenty of room on the screen for some helpful core vocabulary 
that can be used to create complete sentences without having to navigate away from the 
breakfast page. Once you have only 3 or 4 columns, though, these extra core words start to 
push the breakfast words down the page, so that the user has to scroll past the core words 
to see the breakfast vocabulary. So for 4 and 3 columns, the core words have been moved 
to the storage priority level. Theyʼre still in the folder, but they are not visible to the user 
when the number of columns is set to 3 or 4. Here is the storage level for each of those 
views. Notice that in 4 and 3 column views, you can see the core words are there, but not for 
5 columns.
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It isnʼt always necessary to have different views for a folder depending on how many 
columns the user has selected. For most of the folders you create, you will just want the 
buttons to “flow” to fill the space available for all sizes of buttons. This type of a view is called 
the All Sizes view. No matter what number of columns is selected, the same buttons are 
displayed in the same order. When you create a folder in Proloquo2Go, it is the All Sizes 
view that is created. All Sizes views behave the way categories behaved in Proloquo2Go 
1.x. You will have to take extra steps to create a folder that shows different buttons when the 
column number is different, and in most cases, you wonʼt need to do that. Here is an 
example of an All Sizes folder, US Money. No matter what you set the number of columns to, 
the same buttons are displayed in the same order:

It is possible to have a folder that has an All Sizes view and views for specific numbers of 
columns. Many of the Core Word fringe folders are constructed this way. This is because for 
many of the fringe folders, it is useful to have core vocabulary on the fringe page when the 
number of columns is high - there is plenty of room for the core vocabulary, and the core 
words allow the user to communicate more efficiently. However, when the number of 
columns gets smaller the core vocabulary starts to fill up the first screenful of buttons, and 
inclusion of the core vocabulary on the fringe pages becomes much less useful. For these 
folders, there is an All Sizes view for the larger number of columns, and views for the smaller 
number of columns where the core vocabulary is moved into storage.

How can you tell what views a folder has? In edit mode, you can use the view tab of the 
tools panel to see what views exist for a folder, and change the appearance of those views. 
Lets look at a simple folder first - US Money has only one view, All Sizes. 
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To see the view(s) in a folder, go to edit mode by tapping the 
pencil icon in the toolbar. Then tap the View tab . It will be 
easier to see all the settings for a view by also tapping the 
expansion button  to show more of the editing panel. Tap 
the Edit View  row to see the list of views available for 
this folder.

This is a list of all the different views that are possible for 
this folder - All Sizes, and views for number of columns 1 - 
12. Views whose names are in black print have been 
created. Views whose names are in gray print have not 
been created. When the user has selected the number of 
columns that corresponds to one of the “gray” views, the All 
Sizes view will be used, and the buttons will flow to fill the 
screen.

Here are the views for Breakfast. You can see that 
Breakfast has an All Sizes view, and views for 3 and 4 
columns. The checkmark is on the 3 column view row 
because the number of columns is currently set to 3. All the 
other views are gray because they have not been created. If 
you tap a gray row, you will be asked if you want to create 
the corresponding view. You should only make new views 
for a folder if you either want to design an optimized view for 
a particular column size or want to display a particular folder 
always with a specific number of columns irrespective of the 
number of columns setting the user is using for the rest of 
the vocabulary. In most cases, all you will need for new 
folders is the All Sizes view.
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5.2. Creating a folder with a fixed number of columns

Sometimes it is useful to create a folder that displays the same number of buttons no matter 
what the user has selected for the number of columns setting. There is some content that is 
best displayed in large buttons, such as photos. There are also circumstances where you 
may want to have a folder of small buttons to be used by a therapist or parent working with a 
user. The therapist or parent who is able to use the small buttons can use them to go to 
folders with larger buttons intended for the user to communicate with.

You can give an existing folder a fixed number of columns or create a new folder and then 
give that new folder a fixed number of columns. To set the number of columns for a 
particular folder enter the folder and then switch to edit mode. Next perform the following 
steps:

Tap the View tab , then tap Edit View . 

Tap the row for the view you want to create. In this example, 
the 4 column view  is tapped.
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Youʼll be asked to confirm that you want to create a new 
folder view.

Note that if there are already multiple views defined for this 
folder you will be asked what view you want to base the new  
view on. For example, if there is already an All sizes view 
and 3 column view, you could choose to base your new 4 
column view on either the All sizes view or the 3 column 
view. The new view will then inherit all the buttons from the 
view you select. 

When the new view is created it becomes the current view 
and will show a check mark.

Tap the back button to go back to the View tab
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Tap Make Default View . This will ensure that the newly 
created folder view is the one that will always be used 
irrespective of the number of columns the user sets for the 
rest of the vocabulary. 

If you do not set your new folder view as the default view, 
this folder view will be shown only when the number of 
columns set by the user matches those of your new view. 

Note that even though you have a 3 column folder view for 
this folder, it will never be shown - instead, this folder will 
always display in 4 columns, because the 4 column view 
has been made the default view.

5.3. Creating optimized versions of a folder for each number of columns

Sometimes you are using Proloquo2Go on more devices and want to use, for example, a 4-
column layout on your iPhone and 7-column layout on your iPad. It is possible to create 
optimized folder views showing just those buttons that are most important on a 4-column 
view, while exposing more vocabulary on the 7-column view that has more space for 
buttons. Similarly you can adjust button positions for each folder view independently, for 
example if you want subject buttons on the left, object buttons in the center and verb buttons 
on the right. For our Core Word vocabulary we have already made optimized versions of 
many folders. You can do something similar for your own folders by creating multiple views 
for the same folder and then optimizing the buttons and/or order of the buttons to best fit a 
specific number of columns.

The previous section explained how to create a folder with a fixed number of columns. To 
create a folder with multiple views optimized for specific number of columns the process is 
quite similar, except that you do not make any of the views Default.

Go into the Folder you want to change and then follow these steps:

- Tap the View tab
- Tap Edit View. 
- Tap the view you want to create. Note that if there are 

already multiple views defined for this folder you will be 
asked what view you want to base the new view on. For 
example, if there are already a 4 column view and 8 
column view, you  could choose to base your new 5 
column view on the 4 column view. The new view will then 
inherit all the buttons from the 4 column view. When the 
new view is created it becomes the current view and will 
show a check mark.

- Tap the back button to go back to the View tab
- Make any changes you want to the content of the folder.
- Tap Done to exit Edit
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Note that as soon as you exit Edit mode Proloquo2Go will display the view that matches with 
the userʼs preferred number of columns. This may be different from the view you just 
created. For example, the All Sizes view may be used or one optimized for the currently set 
number of columns. If you now go to Options and change the number of columns to those of 
the view you just created you will see your just-created view.

If you want to make further changes to your newly created view or the views for other 
column sizes go into the folder. Switch to edit mode and tap the View tab. Then Tap edit view 
and tap on the view you want to edit, for example the 5 column view. Now this will be the 
one shown in edit mode and you can make any changes you want, even if the userʼs current 
preferred number of columns is different. Remember that as soon as you exit Edit Mode you 
will be back in view mode and the view best matching that of the Userʼs options will be 
displayed.
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6. How can I customize Proloquo2Go for an 
individual user?

When you first start Proloquo2Go, you will need to select what type of vocabulary 
organization you would like to use. You have the following choices:

• Core Word Vocabulary
• Basic Communication Vocabulary
• Previous vocabulary [only for updating over 1.x]
• Blank Vocabulary

Section 6.1 will help you understand these different vocabulary organizations and how to 
select the one that best fits the person(s) youʼre setting up with Proloquo2Go. Section 6.2 
will show you how to use the Setup Wizard to select and initialize a vocabulary organization. 
The sections that follow will give you information on further customizing each vocabulary 
organization type to meet each userʼs needs.

6.1. Vocabulary Organizations 

A vocabulary organization is a way of organizing words and sentences in an AAC system so 
that the person who uses the system to communicate can find the right words and 
sentences as quickly and efficiently as possible. How vocabulary should be organized 
depends on the needs of the user - their language level, what size buttons they need for 
access, what kind of things they need to talk about, etc. Weʼll describe the two vocabulary 
organization types in Proloquo2Go, and which type of user each is best suited for.

Basic Communication

The Basic Communication vocabulary organization is designed for users who are just 
beginning to use AAC to express their basic needs. These communicators often start with 
requesting things, people, and activities, but may quickly need to communicate for other 
reasons, like commenting on or describing things, or sharing their news. These users may 
have difficulty navigating between pages in a traditional AAC vocabulary organization, 
especially one with multiple levels.

The Basic Communication vocabulary allows its users to quickly and efficiently make 
requests, refuse or protest, and share basic personal information. The Basic Communication 
vocabulary can be configured to use 3x3, 4x4, 5x5, or 6x6 buttons on a screen. No scrolling 
is required on the main page, and with a few exceptions, the navigation hierarchy is only 2 
levels deep (the main page, and one level of folders that can be reached directly from the 
main page.) To switch between configurations, go to Options > Appearance, and set the 
number of columns to 3, 4, 5, or 6. Basic Communication will not display properly with fewer 
than 3 columns or more than 6, and the number of rows must equal the number of columns.

Once you decide that the Basic Communication vocabulary is appropriate for your user, you 
must select which configuration is appropriate. You can do this based on what button size 
the user can access, how many buttons per screen your user can visually process, and what 
kind of reasons the user wants and needs to communicate about. Remember that if your 
user can handle smaller buttons, but is not ready for some of the reasons for communication 
listed under a particular configuration, you can always hide the buttons that are not yet 
appropriate, and unhide them later as the user progresses.
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Basic Communication 3 column:

Reasons to communicate:

• Request
• Refuse
• Provide basic personal information

Basic Communication 4 column:

Reasons to communicate:

• Request
• Refuse
• Provide basic personal information

Language skills:

• Beginning categorization - food, drinks, toys, TV, activities, 
people

• Access to academic support pages for calendar, numbers, 
letters, colors, shapes in the School folder.

Basic Communication 5 column:

Reasons to communicate:

• Request
• Refuse
• Provide basic personal information and personal news
• Comment (like, donʼt like, use basic adjectives)
• Ask questions
• Attempt to fix communication breakdowns by providing 

clues to what he/she meant to say

Language skills:

• Beginning categorization - food, drinks, toys, TV, activities, 
people

• Access to academic support pages for calendar, numbers, 
letters, colors, shapes in the School folder.
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Basic Communication 6 column

Reasons to communicate:

• Request
• Refuse
• Provide basic personal information and personal news
• Comment (like, donʼt like, use basic adjectives)
• Ask questions
• Attempt to fix communication breakdowns by providing 

clues to what he/she meant to say
• Turn taking

Language skills:

• Beginning categorization - food, drinks, toys, TV, activities, 
people, games

• Access to academic support pages for calendar, numbers, 
letters, colors, shapes in the School folder.

• Access to behavior supports in Rules and Schedule 
folders

Core Word Vocabulary

Core words are words that are used most frequently in conversation and writing. Research 
has shown that a small number of core words such as “I”, “you”, “want”, “it” make up the 
majority of what we say or write. Proloquo2Goʼs Core Word vocabulary provides home 
pages with quick access to these core words, so users can quickly produce complete 
sentences. 

Core words alone are not sufficient for specific and detailed communication. For that, less 
frequently used words such as “cat”, “octopus”, “sleepy”, and “gold” are needed. These non-
core words are called fringe words. Some fringe words are used frequently - for example, 
friend and family names, favorite foods and places, and frequently used social phrases such 
as “How are you?”. Other fringe words are used much less frequently, but are very useful for 
talking about new topics, participating in school, or expanding expressive vocabulary. For 
example, “octopus”, “Bermuda”, and “depressed” are not words many people use every day, 
but it is useful to have access to them when needed.

Proloquo2Goʼs Core Word vocabulary uses the concepts of core and fringe vocabulary to 
arrange vocabulary that is used most frequently “closest” to the user while keeping less 
frequently used vocabulary farther away but still accessible with additional navigation. Core 
vocabulary is presented on the users “home page.” This page contains the most frequently 
used vocabulary, arranged in subject-verb-object order and grouped by grammatical 
category. The borders of the buttons are color coded by grammatical type, helping to draw 
the userʼs eye to the appropriate area of the page to find words as they are needed. 

At the bottom “fringe” of the home page, folder-shaped buttons provide access to fringe 
vocabulary, organized by category (e.g. people, feelings, places, verbs, etc.) Following these 
links, the user finds the primary level of fringe vocabulary - the next-most-commonly used 
words in that category. For example, the home page might have the most commonly used 
prepositions “on”, “off”, “in”, and “out”. The primary page for prepositions might have the next 
most commonly used prepositions such as “for” , “at”, and “from”. This primary page would 

59



not have less frequently used prepositions such as “between” and “ahead”. These less 
frequently used prepositions appear on the next level of navigation - a secondary 
prepositions page which is reached using a link from the primary preposition page. So the 
words the user uses most frequently are on the users main page, with the next tier of words 
one link away, and the last tier of words, two links away.

There is a final level of words, called the storage level. This level is not visible unless you 
are in edit mode. The storage level is where words that are very infrequently used are kept. 
For example, in the storage level for prepositions are the words “among” and “apart.” Those 
with advanced vocabulary needs may require these words, but for many users, having these 
words visible would only get in the way of finding more frequently needed words.
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Proloquo2Goʼs Core Word vocabulary was created using published research on the 
frequency of use of common words by children in preschool and early elementary school. 
Using this data to sort words into primary, secondary, and storage levels works reasonably 
well for the very most commonly used words. Making the distinction between the fringe 
words that are on the primary versus the secondary levels is more difficult to do in a way that 
works equally well for all users. For example, a particular user might need to use the verb 
“fold” more frequently to instruct someone to fold clothing properly - that user would want 
“fold” on the fringe verb page rather than the more verbs page. The Core Word vocabulary is 
designed to make it easy to “promote” a fringe word from the secondary level to the primary 
level, or “demote” it from the primary level to the secondary level. You will learn how to do 
this in the section on customizing your chosen vocabulary.

The top level, or “home” pages of the 3, 4, 5, 6, 7, and 8 column core word vocabulary 
configurations are shown below. All of these configurations may be used on an iPad. On the 
iPhone and iPod Touch, only the 3, 4, 5, and 6 column configurations should be used; on 
these smaller devices, the 6 column configuration is very small and will require excellent 
eyesight and fine motor skills.

To switch between configurations, go to Options > Appearance, and set the number of 
columns to 3, 4, 5, 6, 7, or 8. Core Word will not display properly with fewer than 3 columns 
or more than 8, and the number of rows must equal the number of columns. 

6.2. Using the Setup Wizard to Select a Vocabulary

When you start Proloquo2Go for the first time, the Startup Wizard appears to help you 
create a new user and choose a vocabulary for this user.

Tap the User Name row and type a name to a user, and then choose a vocabulary you want. 
If Available kinds of vocabularies are explained in section 6.1 above.

Q: Can I use vocabulary from an earlier version of Proloquo2Go?
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If you have an earlier version of Proloquo2Go installed on your device, you can use the 
vocabulary from there in Proloquo2Go 3.0. To do so, select Copy of Pre-2.0 Vocabulary in 
Startup Wizard or when creating a new user.

6.3. Customizing Your Vocabulary

Gathering Personalized Vocabulary

When customizing a vocabulary, the first step is find out what things the user will need to 
communicate about. This involves determining the userʼs preferences on things like food, 
activities, music, etc., as well as the names of people, places, and things that are important 
in the userʼs life. See Appendix A for a list of useful information to gather. If possible, gather 
information from family, friends, care providers, and school staff, so that the vocabulary the 
user needs throughout all environments in his or her day is represented. If youʼre updating 
from a pre-2.0 version of Proloquo2Go, you can create a user based on your pre-2.0 
vocabulary, and then copy and paste buttons from the pre-2.0 user. We do not currently 
support copying and pasting folder buttons between users, but will add this feature in a 
future release.

Customizing for Basic Communication

You will use the information you gathered about the user to customize the contents of the 
various folders in the Basic Communication vocabulary:

Things, People, Places, Activities: Add buttons for the things the user will want to 
communicate about into the appropriate folders. For example, if the user loves crackers and 
milk and is using the 3x3 Basic Communication organization, both crackers and milk should 
be added to the “I want” folder. If the user is set up with the 6x6 Basic Communication, 
where things are divided up into different folders, crackers should go in the food folder and 
milk in the drinks folder. 

Some common buttons have been added to the storage levels of the Basic Communication 
folders. When in edit mode, you can go to the Storage level and promote those buttons that 
are important to the user into the Primary level. For example, many people like chips and 
crackers, so these are in the Storage level of “I want” and “Food” in the Basic 
Communication vocabulary, to save you time. Other buttons may be more uncommon, and 
wonʼt be in Storage, so you will need to add an button with the appropriate symbol. For 
example, your user may love pomegranates. This is probably not an button that is in 
Storage, so you will have to add an button for it, and search for the symbol for pomegranate 
when you create the button.

Think carefully about how many buttons you add to each folder. Many people who are 
appropriate for Basic Communication vocabulary may be overwhelmed by long lists of 
potential choices, especially if they need to scroll. Especially at first, limit the buttons you 
add to those buttons you know the user strongly prefers or will want to talk about. As time 
goes on, you can add more buttons at the primary level. If you find your user has many more 
buttons he or she needs to have available in any folder than will fit on a single screen, 
consider keeping the most important ones on the primary level and demoting ones the user 
rarely refers to to the secondary level, so the user does not need to scroll.

I need help: This folder should contain messages the user can use to quickly get assistance. 
Buttons for asking to use the bathroom, feeling sick, something hurts, and a folder for body 
parts are included. Add any other buttons that you feel the user may need to request quick 
assistance that reflect the userʼs unique needs. For example, if the student often needs to 
have his or her AFOs removed or readjusted, you might add a message here.
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I feel: This folder contains some basic feelings. The ability to identify feelings can be both 
important and difficult for a person at the Basic Communication level. It is therefore 
important to keep this folder simple at first, to make the task of identifying emotions easier. 
That being said, if the user has a specific feeling that he or she knows how to identify, or is 
the target of a teaching or behavior goal, you may want to add it here.

About Me: In this folder you will find some buttons that contain sentences you will need to fill 
in with the appropriate information. For example, edit the “I live at” button and add the userʼs 
address to the end of the Text To Speak. If any of the buttons makes no sense for the user, 
feel free to demote it to Storage or delete it. Also remember that in order to protect the userʼs 
privacy, it is important to get permission from the userʼs parents or guardians, or if 
appropriate, the user him or herself before entering any private information.

Chat: This folder contains common social phrases such as “How are you?” and “Please.” 
Buttons are included in Chat to hold news from home and news from school. Edit these 
buttons frequently, preferably every day, so that the user always has new information to 
share.

Home: This folder is included in the 4, 5, and 6 column layouts. It is empty, and is offered as 
a place to put any buttons that would help with home-specific communication.

School: This folder is included in the 4, 5, and 6 column layouts. It contains links to subject 
matter often requested by special education teachers for students who are at the Basic 
Communication level - alphabet, numbers, colors, shapes, weather, and calendar topics. 

Questions: This folder is in the 5 and 6 column layouts. It contains commonly used questions 
such as “Whatʼs that?” and “Where are we going?” The ability to ask questions is a key 
communication skill that may AAC users have difficulty learning, as they are usually 
expected to respond to questions rather than ask them. When you are starting to teach the 
use of this folder, it is best to use a few key, generally applicable questions such as “Whatʼs 
that?”, and model the use of the questions so that the user becomes familiar with how they 
are used and the power they can provide. As the user begins to initiate simple questions, 
you can promote more questions from Storage level up to Primary or Secondary levels.

Describing: This folder, in the 5 and 6 column layouts, contains some early occurring 
adjectives such as good/bad, big/little, yucky, fun, etc.

Clues: This folder, which is in the 5 and 6 column layouts, provides early practice with the 
important skill of communication breakdown repair. A communication breakdown occurs 
when a person is not able to get his or her point across. There are many ways that the 
person can try to fix the breakdown - repeat his message, rephrase his message, or give 
additional information, or clues, about what he meant to say. The Clues folder provides a 
way for the Basic Communication user to tell his communication partner more about what he 
was trying to say by saying what type of thing his message was about - a person, place, 
thing, food, etc. It is important to model use of the Clues folder for the user so he or she can 
learn to use it. As the user becomes more skilled, you can add additional categories of 
“things” into the folder that might be useful for repairing communication.

In the Storage level of the Clues folder, you will find some additional buttons that may help 
users to clarify their communication by providing additional information about what theyʼre 
trying to communicate. Sometimes a communication breakdown can be simply solved if you 
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know the person is asking a question rather than telling you 
something, or is talking about something they wish would 
happen rather than something that is real.  It is a good idea 
to promote these buttons to the primary level for users as 
they reach the ability to use the 6x6 Basic Communication 
layout. You will need to teach the user how to use these 
buttons, and the most effective way is usually to model 
using them yourself, as you talk to the user. So for example, 

if you are switching the topic of conversation, go to the Clues page and select “new topic”; if 
youʼre going to ask a question, select the “question” button, etc. You can also model using 
during a communication breakdown - if youʼre unsure if the user is asking a question or has 
switched to a new topic abruptly, model using the appropriate buttons.

News: This folder is introduced in the 5 column Basic Communication layout, and is included 
in the 6 column as well. It contains buttons for home and school news, as well as a partner 
focused question “What about you?” so the user can take a conversational turn after sharing 
his news. Edit the news buttons frequently, preferably every day, so that the user always has 
new information to share. In the 3 and 4 column layouts, these news buttons are in the Chat 
folder.

Customizing for Core Word

The first decision to be made when customizing Core Word is which column layout to 
choose. The smaller number of columns, the larger the targets are for physical access and 
for visual processing. However, having more buttons per page reduces the need to navigate 
to find additional vocabulary. The trade-offs between these considerations will be different for 
each user. When deciding which number of columns to choose, take the following into 
account:

• How small a target can the user select most of the time, without mis-hits? To allow access 
to smaller targets, you might consider:

• Keyguard

• Stylus or pointer

• Adding space between buttons (see chapter 3, Appearance settings, View section)

• Adjusting the hold time required to register a “hit” on a button (see chapter 3, 
Interaction settings, Buttons section)

• How small a target can the user discriminate visually - in other words, how large must a 
button be in order for the user can reliably tell the difference between two buttons with 
similar symbols? Factors to keep in mind:

• You may be able to use color to make buttons more distinctive

• Consider changes such as making buttons text only or image only, restricting text to a 
single line, changing the space between buttons, or using the device in portrait rather 
than landscape mode. One of these changes may enable the user to better process 
the screen visually.

• Make sure that glare from overhead lights and windows isnʼt interfering with the userʼs 
view of the screen. You might use a matte screen protector to reduce glare, or make 
sure the device is positioned to reduce the potential for glare or reflections.

• Would the user benefit from keeping the location of key buttons constant as he or she 
learns new vocabulary? Some users may only be ready for the number of language 
concepts on a 4 column page when they start using Core Word, but as they begin to use 
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the vocabulary, they may be able to handle more content on the page, and would benefit 
from having the vocabulary they already know stay in the same place. This approach takes 
advantage of learning through motor planning. For example, the user may be able to 
access an 8 column layout on an iPad, but not be ready to handle 64 buttons on a single 
screen due to limited language skills. You can start with an 8 column layout, and use 
hiding and demoting to show only the 16 buttons that are available in a 4 column layout. 
As the user gains language skills, you can gradually add in buttons by unhiding and 
promoting them to give the user access to more language. Detailed instructions for how to 
do this are provided in section 7.1.

Full 8 column Core Word layout 
showing only buttons available in 4 
column layout

Full 8 column Core Word layout 
showing only buttons available in 5 
column layout

Once you have selected the number of columns to use, you can begin to customize the 
content of the vocabulary using the personalized information you gathered at the beginning 
of this process. No matter what column layout has been selected, all Core Word vocabulary 
users have access to the following folders. The path they take to reach the folders may 
differ, however.

• About Me: This is found inside the Chat folder, and should be customized with the userʼs 
personal information (name, address, phone number, age, etc.)

• Family, Friends, Teachers, and Heath care providers: These folders are found in the 
People folder, and should be personalized as necessary with the names (and if available, 
pictures) of the actual people for this user. If you donʼt have photos of the people available, 
you may be able to use a SymbolStix symbol that looks somewhat like the person. Use 
one of these words when you search for a symbol, and youʼll see multiple symbols with 
variations in hair style and skin coloring. You may need to scroll down a bit to find these 
symbols.

• woman
• man
• girl
• boy
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• Help: This folder should contain messages the user can use to quickly get assistance. 
Buttons for common situations such as asking to use the bathroom and feeling sick are 
included, and additional buttons can be found in the secondary and storage levels. Add 
any other buttons that you feel the user may need to request quick assistance that reflect 
the userʼs unique needs. For example, if the student often needs to have his or her AFOs 
removed or readjusted, you might add a message here.

• Food: If this folder is not on the main page for your user, it will be on the secondary level, 
or reachable through the Things folder. For each subfolder in Food, use promotions and 
demotions to make the foods the user is most likely to talk about are on the primary level 
of each subfolder. For example, if you are working with someone who loves Dr. Pepper 
and dislikes Coca-Cola, in the Drinks folder, demote Coke from the primary level to the 
secondary and promote Dr. Pepper from secondary to primary.

• Clothing: Check to make sure any item of clothing that would never be of interest to a user, 
is not needed in the userʼs climate, or is culturally inappropriate, is demoted to secondary 
or storage levels. Promote buttons that are in secondary or storage that the user may need 
to refer to frequently.

• Fun: In each subcategory, make sure that buttons the user is most interested in are on the 
primary level, and those of little interest are demoted to secondary or storage. In Sports 
and TV Shows, consider finding photos on line of favorite famous people who belong in 
these categories. 

In Sports, there are folders specific to particular sports. Some of the most popular sports in 
the US are on the primary level, while folders for sports more popular in other regions such 
as cricket and rugby can be found on the secondary level. In the storage level of the folder 
for some sports, you can find buttons with the names of popular teams and players. 
Availability of these buttons depends on whether SymbolStix has created the appropriate 
symbols. Use promotion and demotion to make sure that sports and teams that your user 
wants to talk about are readily available.

• Personal care, Adaptive Equipment: Use promotion and demotion to customize the 
primary level of this folder to reflect the userʼs needs.

• Describing words: If the user has favorite words to use when describing, use promotion, 
demotion, or add new buttons to make sure these words are easily accessible in the 
subcategories in Describing words. For example, the local dialect may use “wicked 
awesome” to describe something really good. This can be made available to the user by 
adding an button in Positive describing words.

• Clues: This folder contains messages that can be used to help fix communication 
breakdowns - situations where the user is not able to get his or her point across clearly.  
There are many ways that the person can try to fix the breakdown - repeat his message, 
rephrase his message, or give additional information, or clues, about what he meant to 
say. The Clues folder provides a way for the Core Word user to tell his communication 
partner more about what he was trying to say by telling what type of thing, event, or action 
his message was about, describing characteristics of what he is talking about (big/little, 
shape, color), or telling in which locations his topic might be found. It is important to model 
use of the Clues folder for the user so he or she can learn to use it. 

In the Clues folder, you will find some additional buttons that may help users to clarify their 
communication by providing additional information about what theyʼre trying to 
communicate. Sometimes a communication breakdown can be simply solved if you know 
the person is asking a question rather than telling you something, or is talking about 
something they wish would happen rather than something that is real. You will need to 
teach the user how to use these buttons, and the most effective way is usually to model 
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using them yourself, as you talk to the user. So for example, if you are switching the topic 
of conversation, go to the Clues folder and select “new topic”; if youʼre going to ask a 
question, select the “question” button, etc. You can also model using during a 
communication breakdown - if youʼre unsure if the user is asking a question or has 
switched to a new topic abruptly, model using the appropriate buttons. 

For some users, using Clues effectively can be an advanced skill. These users might 
benefit from moving the Clues folder to the secondary level and moving another folder up 
to the primary level. If you find a user is not ready for Clues, and frequently needs to go to 
secondary to find words in Places or Time words, this may be a sign you should move 
Clues to secondary and let another folder take its place in the primary level.

• School: This folder can be found on the secondary level of the main page. It contains 
folders that may be useful as part of a school curriculum. It is recommended that this folder 
be customized in consultation with the userʼs teacher.

• Geography: This folder can be found on the secondary level of the School folder. In the 
secondary level of the Geography folder, you will find folders with the Australian states, 
Canadian Provinces, United Kingdom countries, and US States. If your user needs one of 
these folders, we recommend you promote it to the primary level of Geography, or use 
copy/paste to move the folder where your user needs it. 

• Money: Symbols are available for US, Canadian, UK, Swiss, Danish, and Norwegian 
currencies. They are in separate folders in the Money folder, in either the primary or 
secondary level. Feel free to use demotion, promotion, hiding, or copy/paste to move the 
currency the user will need access to into place.

• Time words: This folder can be found on the primary or secondary level of the home page, 
depending on the number of columns selected . It contains categories such as days of the 
week, months, and seasons, which many special education programs use for daily 
calendar activities. 

• Religion: This folder can be found on the secondary level of the home page, or in storage, 
depending on the number of columns selected. We recommend you look at the primary 
and secondary levels of this folder and customize it to reflect the userʼs needs and the 
local cultural requirements. We have provided basic folders for Christian, Catholic, Jewish, 
and Muslim religions, but recognize that these folders will need to be customized further to 
suit individual needs.
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7.  Progressing Through Core Words
It is important to plan for progression and growth in a userʼs language skills. As a user gains 
practice with a vocabulary organization, and builds new receptive and expressive language 
skills, he or she will need access to additional vocabulary. Core Word has been designed to 
grow with the user, offering expanded vocabulary as the user is able to take advantage of it. 
This can be done in one of two ways - by increasing the number of columns per page, or by 
starting out with a larger number of columns than needed and hiding more advanced buttons 
until they are needed.

7.1. Progressing a user by increasing number of columns

Proloquo2Go makes it easy to increase the amount of vocabulary available to a user by 
simply increasing the number of columns in a page. All of Proloquo2Goʼs built-in 
vocabularies are designed so that increasing the number of columns results in a layout 
optimized for that number of columns which includes new words at the next level of 
frequency of use and language development. For example, see figure in section 6.1, 
showing the progression of Core Word vocabulary from 3 columns per page up to 8 columns 
per page. 

To change the number of columns per page, see chapter 3, Appearance, in the View section.

Follow a column number increase, the user may initially have difficulty locating buttons 
previously learned. All the buttons from the previous version of the pages are present on the 
new one, and every effort has been made to maintain the buttons in the same general area 
in which they were on the previous page layout. However, the buttons will not be in exactly 
the same place, and they will also be smaller. Give the user time to adjust to this change. 
You may want to take a screen shot of the previous main page and print it out, then use it to 
conduct a tour or treasure hunt, where you and the user locate where all the buttons have 
shifted to on the new page.

7.2. Progressing a user by hiding and revealing buttons

Progression by increasing the number of columns will work well for many users. However, 
there are some users who will benefit significantly from having previously learned buttons 
remain fixed while new buttons are added around them. This minimizes the new learning 
needed as the user progresses in vocabulary size. In order to benefit from this approach, the 
user must be able to physically access buttons for a high number of columns per page, but 
be at a language level that is better suited for a low number of columns per page. This 
approach tends to work better on the iPad than the iPod Touch or iPhone, where buttons on 
the high column layouts are larger.

1. Determine the smallest size button your user can access by setting the number of 
columns on a page progressively higher on a page and having the user attempt to 
accurately target buttons throughout the page. Call this number of columns the “target 
number.”

2. Determine the number of buttons per page most closely matches the userʼs current 
language skills. This can be difficult to do in practice. One approach is to observe the 
user with the main Core Word page in with different numbers of columns and see at 
which point the user seems to become confused or overwhelmed at the number of 
buttons available. Call this number of columns the “starting number.”

3. Set the number of columns to the “target number” and go to the Core Word main page.
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4. Find the list of words and folders on for the “starting number” in Appendix B.

5. Go into edit mode. Select all button buttons that do NOT appear on the list of words for 
“starting number”. Tap the Appearance tab, then scroll down to the Visibility row. Tap that 
row and select Hidden. All these buttons will now appear dimmed.

6. Now find the folders that do NOT appear in the list of folders for “starting number.” You 
have two choices in how to handle these. If you think the user can handle or benefit from 
having these folders visible at the primary level, you can leave them as they are. If you 
think the user would have greater benefit from having fewer buttons on the screen at one 
time, you can demote these buttons to the secondary level. You donʼt have to do the 
same thing with all the folders; you can make this decision on a folder-by-folder basis. 
For example, if the user is very focused on food, you may want to leave the food folder 
on the main page, even though it is not on the main page for the “starting number” 
layout. It is recommended that you demote the folder(s) to secondary rather than hide 
them because if the folders are demoted, the user can still find these folders by going to 
the secondary level. Hiding the folders altogether may overly restrict the vocabulary the 
user has access to. However, it is certainly fine to hide the folders if that seems a better 
solution for a particular user. 

Note: before you demote the folders, make sure that the home page has “Free 
Positioning” as its Element Order. To check, while youʼre in edit mode, tap the View tab 
and scroll to the Element Order row. If this doesnʼt say Free Positioning, tap the row and 
select Free Positioning in the list. With Free Positioning on, buttons will not move around 
to fill gaps in the page when the folders are demoted.

7. Leave edit mode. Youʼll now see a main page with many gaps where buttons have been 
hidden or folders demoted. You can gradually reveal buttons and promote folders to 
support the userʼs growing language skills.
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8. Backing up and restoring your vocabulary
Backing up your vocabulary is very important and something you should regularly do! Once 
you have backed up your vocabulary, you can transfer this vocabulary to another device or 
restore your vocabulary to a device at a later date. You can either store backups on your 
computer or export them to Dropbox storage.

8.1. Creating backups

Backing up a single userʼs vocabulary file

Launch Proloquo2Go, and make sure the user you want to 
back up is the currently active user. If it is not, go to the 
User section of the Options view and switch to the user you 
would like to back up. 

Once the user you want to back up is the currently active 
user, go to the Options view (section 3.1), and then, in the 
Backup section, tap "Backup [user name] Now" . Once 
the backup is complete, exit Proloquo2Go by pressing the 
home button.

Backing up vocabulary files of all users

To backup vocabularies of all users, go to the Options view, 
open the Backup section, and then tap “Backup All Users 
Now” .

Automatic backups

Proloquo2Go automatically creates a backup for each active 
user once a day. The automatically created backup files are 
marked with the special icon . You can use these 
backups just like usual backup files. When there are already  
eight automatic backups for a certain user, the oldest file is 
replaced with a new one.

8.2. Exporting backups

After you have created backups, export them to Dropbox or iTunes. If you wouldnʼt do so, 
you will not be able to transfer your vocabulary to another device or transfer your backup 
files to the computer with iTunes File Sharing.
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Exporting to iTunes 

Open the Backup section of Options and tap the Export 
Backups row.

Tap the name of the backup that you want to export.

Tap Export to iTunes.

A progress bar appears next to the name of the backup you 
are exporting. Tap the cancellation button  to interrupt the 
export process.
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After the backup has been exported, a message will appear, 
to let you know. Tap OK to return to the Export Backups 
screen.

You can now transfer the exported backup to your computer 
using the iTunesʼ File Sharing.Refer to the section 8.3 
“Transferring with iTunes File Sharing using the dock 
connector cable”.

Exporting to Dropbox

Open the Backup section of Options and tap the Export 
Backups row. If Dropbox integration is OFF, slide the 
Dropbox Integration switch  to turn it ON. 

Proloquo2Go will now ask for permission to connect to your 
Dropbox account. There are two ways this may be done.

1. If the Dropbox app is not installed on your device

If you donʼt have the Dropbox app installed on your 
computer, the Safari web browser will open to the Dropbox 
website. You will need to enter email address and password 
that you use to access your Dropbox Account.

Type your email address and password and tap Sign in.

If you connect to Dropbox using Proloquo2Go for the first 
time, the folder Apps / Proloquo2Go will be created in your 
Dropbox. Backup files that you export will be stored in it.
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2. The Dropbox app is installed on your device

The Dropbox app will be opened. If you havenʼt yet logged 
into Dropbox using the Dropbox app, you will be asked for 
the email address and password you use to access your 
Dropbox account. Also when you open the Dropbox app you 
may be asked if you want to receive notifications from 
Dropbox (see screen shot on the left). You may either agree 
or disagree with this, because you can later configure this 
behavior in Settings. Your answer does not affect whether 
you can use Dropbox with Proloquo2Go.

Now you will be asked if Proloquo2Go should be allowed to 
have access to a folder in your Dropbox. Tap the button 
labeled Allow.

Dropbox will only ask for your permission the first time you 
access it through Proloquo2Go.

If you were switched to another app in order to sign in to 
Dropbox, switch back to Proloquo2Go. In the Export 
Backups screen, tap the name of the backup that you want 
to export.
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Tap Export to Dropbox.

A progress bar appears next to the name of the backup you 
are exporting. Tap the cancellation button  to interrupt the 
back up process.

After the backup has been exported, a message will appear 
letting you know the export succeeded.. Tap OK to return to 
the Export Backups screen.
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8.3. Transferring with iTunesʼ File Sharing using the dock connector cable 

Important Note: If you are connecting your device to a computer you do not usually synch 
your device to, be sure to disable iTunes' automatic syncing so you do not overwrite your 
device's contents! Follow these steps before you attach your device to any new computer. 

Launch iTunes. To disable iTunes' automatic syncing on a Mac computer, make sure iTunes 
is the active application, and then select the iTunes menu at the top left corner of the screen, 
next to the Apple. Click on Preferences , then click the Devices tab  in the window that 
appears. Click the check box for “Prevent iPods, iPhones, and iPads from syncing 
automatically” . Then click OK . On Windows, you will find Preferences at the bottom of 
the Edit menu . 

Mac: Windows:

• Export backups to iTunes (refer to the section 8.2 “Exporting Backups” earlier in this 
document).

• Connect the iPhone/iPod/iPad to your computer using the dock connector cable that you 
also use to synch with iTunes.
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• Launch iTunes. (Note that if your device is normally synched with another computer make 
sure that you do not allow iTunes to change your apps, music, photos or other things if 
iTunes asks you about this).

• Wait until your device appears in the iTunes sidebar  on the left and then click on your 
device.

• Click on the Apps tab  in the iTunes window.

• Scroll the page down until you reach the File Sharing section .

• Select Proloquo2Go .

• Select backups you want to save in the Proloquo2Go Documents list in iTunes  and 
click the “Save to...” button  to save the backups on your computer. Note that you may 
see several backup files in iTunes. Backup file names start with the name of the user they 
contain. Each user is backed up in a separate file.

• You are now done transferring the backups to your computer. In case you want, you can 
rename a file (but keep the extension .p2gbk), copy the file to another computer or put it 
on a USB stick. Or, you can use the backups to restore another device running 
Proloquo2Go to the exact same vocabulary contents.

• If you want to upload an old backup or a backup from another device to Proloquo2Go, click 
the “Add ...” button  at the bottom of the Proloquo2Go Documents list in iTunes and 
choose a file with the .p2gbk extension from your computer that will then be uploaded to 
Proloquo2Go. (Refer to the section “Importing backups” for more information.) 
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8.4. Transferring with your web browser using a Wifi network

General Instructions

1) Connect the iPhone/iPod/iPad to Wifi (see the Settings app) on the same local network 
as your computer.

2) Launch Proloquo2Go, go to the Options View (see section 3.1), tap the Backup row, and 
then tap "Connect to Computer". Next, follow the instructions on the screen.

3) Launch Safari or FireFox web browser on your computer (Internet Explorer is not 
currently supported), and enter the URL that is displayed in the Proloquo2Go Connect to 
Computer screen.

Steps specific to saving a backup onto your computer

4) On your computer, use the web page that appears to download backups from 
Proloquo2Go to your computer. The pages shown in the web browser provide additional 
details.

Steps specific to restoring Proloquo2Go from a backup on your computer

4) On your computer, use the web page that appears to upload a previously downloaded 
backup to Proloquo2Go so that you can restore from it. The pages shown in the web 
browser provide additional details. 

5) If you want to restore Proloquo2Go to a state stored in a backup document, you need to 
first upload the backup document to Proloquo2Go from the web browser on your 
computer and then use the Proloquo2Go "Restore from Backup" feature. See section 8.6 
below.
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8.5. Importing backups

To restore from a backup that youʼve added to your device using iTunes File Sharing, or that 
youʼve put in Dropbox, you will first need to import the backups into Proloquo2Go.

Importing from iTunes File Sharing

To import your backups from iTunes, follow these steps:

• Connect your device to the computer on which backup files are stored. Refer to the section 
“Transferring with iTunesʼ File Sharing using the dock connector cable”.

• Make sure backup file you want to import is in the Proloquo2Go Documents list in iTunes. 
If you cannot find it where, click the “Add...” button, browse to its location on your 
computerʼs disk, and then click Add.

On your device, open the Backup section in Options and tap 
Import Backups.

You will see that the backup file you want to import appears 
in the iTunes File Sharing group.Tap the backup name to 
import it.

78



You will be asked if you want to import the file from iTunes. 
Tap Import.

After the backup file was successfully imported, you may 
either use it to restore your data immediately or just store it 
on your device for later use.

To start restoration immediately, tap Restore Now.

To store the file on your device, tap Later. Refer to the 
section “Restoring Proloquo2Go from a backup file” for more 
information on how to restore from this backup at a later 
time.
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Importing from Dropbox using the Dropbox app

Open the Dropbox app on your device and open the Apps / 
Proloquo2Go folder in it.

From the list of backup files stored in your Dropbox, choose 
a file you want to import and tap it.

When asked, tap “Open in Proloquo2Go”.
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You may either use the backup file to restore your data 
immediately or just store it on your device for later use.

To start restoration, tap Restore Now.

To store the file on your device, tap Later. Refer to the 
section “Restoring Proloquo2Go from a backup file” for more 
information.

Importing from Dropbox without the Dropbox app

On your device, open Safari and go to the website 
dropbox.com. After the webpage is loaded, enter email 
address and password that you use to open your Dropbox.

In Dropbox, open the Proloquo2Go folder and tap the 
backup file that you want to import (see screen shots 
below).
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In the screen with file details, tap the “Open in 
ʻProloquo2Goʼ” button.

You may either use the backup file to restore your data 
immediately or just store it on your device for later use.

To start restoration, tap Restore Now.

To store the file on your device, tap Later. Refer to the 
section “Restoring Proloquo2Go from a backup file” for more 
information.

8.6. Restoring Proloquo2Go from a backup file

To restore from backups, you must put them on your device 
first (see earlier sections in this chapter), and then follow 
these steps:

• On your device, go to Options and tap the row labeled 
Backup, then tap Restore from Backup. If you canʼt select 
the Restore from Backup row, make sure "Restore from 
Backup" is set to ON in the Restrictions part of the Options 
view (see section 3.1).

• Tap the row of the backup you wish to restore from. If you 
have multiple users set up in Proloquo2Go on your device, 
you can restore from the backups of any user on the 
device. Here you see the backups of a copy of 
Proloquo2Go that has three users - Simon (the currently 
running user), Jennifer, and Tracy.
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• If you select a backup from a different user than the one 
that is currently active, youʼll be asked what youʼd like to 
do. You can either overwrite the current user with the 
backup from the other user, or you can switch to the other 
user and restore it from the selected backup file. 

Here, a backup from the user Jennifer has been selected, 
but the currently active user is Simon.
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8.7. Restoring from a Proloquo2Go 1.x backup file

To restore a user from a Proloquo2Go 1.x backup file, 
get the .p2gbk file from your computer into 
Proloquo2Go in any of the ways described above. 
Then go to the Restore from Backup view. 

Youʼll see that there is a new section in the list of 
backups, called Proloquo2Go 1.x userʼs backups. All 
backups made from Proloquo2Go 1.x will appear in this 
section. 

Tap the update you wish to restore, and respond OK to 
the confirmation request.
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8.8. Restoring from your original 1.x vocabulary backup

When you update from 1.x to 3.0, Proloquo2Go will save a copy of your original 1.x 
vocabulary. You can copy this file to your computer. You can also use this file to 
create a new user with your original 1.x Proloquo2Go vocabulary, or overwrite one of 
your 3.0 users with your 1.x Proloquo2Go vocabulary. In this way, you will be able to 
backup and recover your original vocabulary, should anything go wrong with the 1.x 
to 3.0 update process.

Saving your 1.x vocabulary backup to your computer

From Options, tap the row marked Backup. If you 
updated from 1.x to 3.0, you will see a button labeled 
Copy v1.x vocabulary to iTunes. 

Tap this button, and a copy of your original vocabulary 
backup file will be placed in the folder that is visible in 
iTunes when your device is connected to your 
computer. This file will be called 
Version_1_Vocabulary.p2gbk.

Follow the directions in the section above, Backing up 
a userʼs vocabulary to your computer, to copy this file 
to your computer.

Creating a new user from your 1.x vocabulary

From the main Options screen, tap the row marked 
User. On the next screen, tap Add User.

Tap the User Name text field and type in the name of 
your new user. Then tap the row labeled Vocabulary.
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Tap the row labeled Copy of Pre-2.0 Vocabulary, and 
tap the back button to return to the previous screen.

If you would like to use your original 1.x default settings 
of for your options, tap the Options row and select 
“Copy of Pre-2.0 Options”.

When youʼve selected the vocabulary and options you 
want, tap the blue Save button, and your new user will 
be created.

Using your 1.x vocabulary to overwrite an existing user

From the main Options screen, select Backup, and 
then Restore from Backup.

If you have updated from 1.x to 2.x or 3.x, you may 
notice a section labeled Proloquo2Go 1x.userʼs 
backups. The backup from this list that has the date 
you first updated from 1.x is a copy of your vocabulary 
at the time you updated. It may be named 
Version_1_Vocabulary.

To overwrite the currently active user with this 
vocabulary, tap backup with the appropriate date.

If you do not see an appropriate backup, return to the 
main Backup screen and tap the row labeled Copy v1.x 
vocabulary to iTunes. Then go to Import Backups and 
youʼll see a Version_1_Vocabulary in the iTunes File 
Sharing list. Tap this vocabulary to import it into the list 
of backups you can use for restoring. When you return 
to the Restore from Backup view, you will see your 1.x 
vocabulary file as a choice.
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8.9. Deleting backups

You may want to delete some of the previously created 
backups if there are too many of them on your device 
or for some other reason. To do so, go to the Backup 
section and tap the Delete Backups row .

You will see a list of backups on your device sorted by 
users they belong to. Tap the Edit button to be able to 
delete the backups you want.

Tap the “minus” icon next to the backup that you want 
to delete, and then tap the Delete button. If you want to 
delete all backups that belong to a certain user, tap the 
“Delete All Backups” button  (in the case that is 
shown in the figure to the left, all Simonʼs backups will 
be deleted).

Tap Done to return to the Backup view.
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9. Edit Pronunciation
9.1. The Basics

Inside the Options view (see section 3.1), under Speech > Pronunciation, you can edit 
pronunciations. To access this feature, with voices downloaded for an earlier version than 
1.2, you will have to re-download the voice. 

The easiest way to Edit Pronunciation is by attempting to spell the word in another way. For 
example, for french fries you can simply put french frys. Note: You may need to be creative. 
You can test out your pronunciations by tapping the speak button.

When the original text is entered in all lower case it will match all forms of the word. So "dog" 
will match "dog", "Dog", but also "dOg". If the original text includes capitals it will only match 
similarly capitalized words (i.e. “David” will only match “David” and not “david”). In other 
words it becomes case-sensitive. 

There are some limitations in terms of what transcriptions the voices can properly handle. 
Putting spaces or other punctuation inside the pronunciation text can sometimes lead to 
strange effects. The best way to check whether the voices can handle a pronunciation 
correctly is testing it with the Speak button. The only way to guarantee a perfect 
pronunciation is to use the phonetic codes discussed below.

9.2. Phonetics (for advanced users)

This section is adapted from the Acapela Language Manuals

American English

The American English text-to-speech system uses the American English subset of the 
SAMPA phonetic alphabet (Speech Assessment Methods Phonetic Alphabet), with a few 
exceptions. The symbol o was replaced by @U (ex. nose), e was replaced by EI (ex. hate), 
aI was replaced by AI (ex. light), and 3` and @` were replaced by r= (ex. furs, corner). The 
symbol 4 was also introduced to represent a flapped t (ex. better). The symbols are written 
with a space between each phoneme.

In words with more than one syllable, one (and normally only one) of the syllables is more 
prominent than the others. This is referred to as word stress, or lexical stress. Words of one 
syllable also have word stress when spoken in isolation, although many may lose the stress 
in certain contexts. For the correct pronunciation of a word, it is important to include the 
symbol marking the word stress.

In the phonetic transcriptions the word stress is indicated by the symbol 1 placed directly 
after the stressed vowel (with no space between the vowel symbol and the stress symbol).

A secondary lexical stress can also be used. This secondary stress is indicated by the 
symbol 2 placed directly after the stressed vowel like 1 for primary stress.

A glottal stop, represented by the phonetic symbol ?, is a small sound which is often used to 
separate two words when the second word starts with a stressed vowel. This sound can be 
inserted in a transcription in order to improve the pronunciation.

An underscore _ in a phonetic transcription generates a small pause.
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Phonetics Codes for American English: Consonants

Sound Code for the sound Example

b as in bad b b {1 d

c as in cone k k @U1 n

ch as in chin tS tS I1 n

d as in date d d EI1 t

f as in fat f f {1 t

g as in gag g g {1 g

g as in gin dZ dZ I1 n

h as in hit h h I1 t

l as in let l l E1 t

m as in man m m {1 n

n as in nose n n @U1 z

ng as in ring N r I1 N

p as in pipe p p AI1 p

r as in rose r r @U1 z

s as in sat s s {1 t

s as in measure Z m E1 Z r=

sh as in shin S S I1 n

t as in tab t t {1 b

tt as in better 4 b E1 4 r=

th as in this D D I1 s

th as in thin T T I1 n

v as in vote v v @U1 t

w as in wait w w EI1 t

y as in yacht j j A1 t

z as in zoo z z u1

Phonetics Codes for American English: Vowels

Remember that in the phonetic transcriptions the word stress is indicated by the symbol 1 placed 
directly after the stressed vowel (with no space between the vowel symbol and the stress symbol).
A secondary lexical stress can also be used. This secondary stress is indicated by the symbol 2 
placed directly after the stressed vowel like 1 for primary stress.
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Sound Code for the sound Example

a as in pat { p {1 t

a as in allow @ @ l aU1

ai as in main EI m EI1 n

er as in corner r= k O1 r n r=

e as in net E n E1 t

ea as in neat i n i1 t

I as in lit I l I1 t

igh as in high AI h AI1

o as in nose @U n @U1 z

o as in pot A p A1 t

oo as in zoo u z u1

ou as in pout aU p aU1 t

ou as in thought O T O1 t

oy as in boy OI b OI1

u as in hut V h V1 t

u as in put U p U1 t

British English

Lexical Stress

A lexical accent is used to indicate the level of prominence (or emphasis) of a syllable in a 
word. In British English, some words can be differentiated by the position of this lexical 
accent. The word record is an example of this since it can be both a noun (a record: r e1 k 
O: d) or a verb (to record: r I k_h O:1 d). Practically all words in British English have a lexical 
accent even if it does not always serve to differentiate between two different words. It is 
therefore important to include stress marks when writing phonetic transcriptions.

In the phonetic transcriptions, primary accent is indicated by the symbol 1 placed directly 
after (no space) the accented vowel. Secondary accent is indicated by the symbol 2. Some 
examples:

devastating d e1 v @ s t eI2 t I N

devastation d e2 v @ s t eI1 S n=

devotee d e2 v @ t_h i:1
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A glottal stop, represented by the phonetic symbol ?, is a small sound which is often used to 
separate two words when the second word starts with a stressed vowel. This sound can be 
inserted in a transcription in order to improve the pronunciation.

An underscore _ in a phonetic transcription generates a small pause.

Phonetics Codes for British English: Consonants

Word Symbol Example

b as in bad b b {1 d

c as in scone k s k O1 n 

c as in cone k_h k_h @U1 n

ch as in chin tS tS I1 n

ch as in loch x l Q1 x

d as in date d d eI1 t

f as in fat f f {1 t

g as in gag g g {1 g

g as in gin dZ dZ I1 n

h as in hit h h I1 t

h as in exhume hj e k s hj u:1 m

l as in let l l e1 t

l as in adult L {1 d V L t

Ll as in Llandaff hl hl {1 n d @ f

m as in man m m {1 n

n as in nose n n @U1 z

ng as in ring N r I1 N

p as in pad p_h p_h {1 d

r as in rose r r @U1 z

s as in sat s s {1 t

s as in measure Z m e1 Z @

sh as in shin S S I1 n

sp as in sport p s p O:1 t 

t as in top t_h t_h Q1 p

t as in stop t s t Q1 p 

th as in this D D I1 s
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Word Symbol Example

tha as in thin T T I1 n

v as in vote v v @U1 t

w as in wait w w eI1 t

y as in yacht j j Q1 t

z as in zoo z z u:1

Phonetics Codes for British English: Vowels

Word Symbol Example Comment

a as in pat { p_h {1 t

a as in father A: f A:1 D @

a as in allow @ @ l aU1

ai as in main eI m eI1 n

ance as in renaissance A~ r e n eI1 s A~ s French vowel

e as in net e n e1 t

ea as in near I@ n I@1

ea as in neat i: n i:1 t

ere there e@ D e@1

en as in sudden n= s V1 d n=

I as in bit I b I1 t

I as in vin E~ v E~1 French vowel

igh as in high aI h aI1

le as in battleaxe l= b {1 t l= { k s only before 
vowels

le as in battle L= b {1 t L= word finally or 
before 
consonants

m as in atheism m= eI1 T i I z m=

o as in dot Q d Q1 t

o as in nose @U n @U1 z

on as in avignon O~ {1 v i n j O~ French vowel

oo as in zoo u: z u:1

or as in history r= h I1 s t r= i

92



Word Symbol Example Comment

ou as in pout aU p_h aU1 t

ou as in four O: f O:1

oy as in boy OI b OI1

u as in fur f 3:1

u as in hut V h V1 t

u as in put U p_h U1 t

ure as in sure U@ S U@1

u as in the second u in 
punctual

u p_h V1 N k tS u 
@ L

y as in locally i l @U1 k @ l i
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10.Presenting on an external display

It is possible to mirror the Proloquo2Go screens onto 
an external display using the Apple VGA Adapter (for VGA 
projectors and televisions) or the Apple Digital AV Adapter 
(for HDMI televisions and displays). This can be very 
practical if you want to demonstrate the use of Proloquo2Go 
during a presentation or training.

Simply connect the Apple Adapter to your iPad, iPhone 4 (or 
later) or iPod touch 4th generation (or later). If your device is 
an iPad 2 or later, what appears on your device screen will 
automatically appear on the external display. If your device 
is not an iPad 2 or later, a message will appear on the 
screen asking you to pick a resolution. Generally speaking, 
you will get the best results if you select the 1024 x 768 
pixels option. Also note that the iPad delivers 
the best quality on the external display.

When presenting to a group on an external display, it can be 
important to make sure your audience knows where you are 
tapping the screen. Proloquo2Go makes screen taps visible 
with a feature called PresenterTouch™. When an external 
display is attached, a small circle will appear wherever your 
finger(s) touch the screen. 
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11.Access Methods

To meet special physical needs that users may have, Proloquo2Go provides multiple access 
methods. One of these is Direct Access, which requires users to touch buttons directly on 
the screen. Direct Access can be adjusted to ignore touches that last less than a specified 
time. In 3.0, Proloquo2Go is able to handle multiple fingers on the screen at the same time. 
The user can specify if Proloquo2Go should pay attention to only the first finger that touches 
the screen, or only the first finger that lifts off the screen.

The other method is Switch Access. In this access method, items are highlighted one by one 
or by groups and the user taps external switches or large areas on the device screen to 
make a selection. There are several modes of scanning and selection, and they are 
discussed later in this chapter.

11.1. Direct Access

Go to the Options view and open the Access Method 
section.

To make Proloquo2Go ignore touches that last less than a 
certain time, specify this time by tapping the plus and minus 
buttons in the Hold Duration row. You can also tap on the 
numbers between the plus and minus buttons, and a 
keyboard will appear so you can type in a number.

To handle multiple fingers on the screen at the same time, turn on the Select on Release 
option. Note that to enable Select on Release, you should first open your device's General 
settings , go to the Accessibility pane  , and then choose VoiceOver as a Triple-click 
Home action .
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When Select on Release is turned on, tap the Configuration 
row to set up Select on Release 

Tap the Mode row to choose which finger(s) you want 
Proloquo2Go to pay attention to. With First Finger Down, 
Proloquo2Go will only pay attention to the first finger that 
touches the screen. Other touches to the screen are 
ignored. When the first finger that touched the screen lifts off 
the screen, the button that finger on when it lifted off is 
selected. With First Finger Up, Proloquo2Go pays attention 
to all fingers on the screen until the first finger lifts up off the 
screen. The button that is under the first finger that lifts off 
the screen is the one that is selected.

Tap the Visual Cue row to change color and width of the 
border that appears around the buttons on the screen as 
they are tracked.

11.2. Switch Access

Proloquo2Go 3.0 gives switch users access to five different scanning modes and advanced 
settings to fine-tune scanning behavior to match individual physical needs. When switch 
access is turned on, additional visual elements appear on the devices screen.
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Tap the Scanning switch to turn switch access on.Tap 
Configuration to set up related options (see below).

Note that to enable switch access, you will need to make 
sure VoiceOver is enabled in your Triple-Click Home list of 
actions. If you have not done this, you will get an alert 
message with instructions when you turn on Scanning. See 
the section above on Select on Release for details.

After you have opened the Scanning settings by tapping 
Configuration in the Access Method screen, you can choose 
a scanning mode, pattern, speed, and what switch(es) you 
would like to use. You can further fine-tune your set-up with 
the advanced settings, described later.

Scanning Modes

Tap the Mode row to select a scanning mode. The scanning 
mode will determine how many switches you will use, and 
how these switches will control the scan. Refer to the table 
below for details which will help you choose the most 
appropriate mode.
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Scanning Mode Number of 
Switches

Can Use 
Screen as 

Switch

Can Use 
External 
Switch

Automatic Scanning
- Highlight advances automatically from item to 

item. Hit switch when desired item is highlighted.
- Best for users who:

- can handle timing and attention demands of 
watching and waiting for an item to be 
highlighted

- can hit switch reliably in a narrow time window

1 Yes Yes

Automatic Selecting
- Highlight advances automatically from item to 

item. If switch is NOT hit while item is highlighted, 
the item is selected.If switch IS activated while 
item is highlighted, highlight moves to next item 
immediately.

- Best for users who:
- can handle timing and attention demands of 

watching and waiting for an item to be 
highlighted

- can hit switch reliably in a narrow time window
- can hit switch many times in a row without 

difficulty

1 Yes Yes

Inverse Scanning
- Highlight advances automatically from item to item 

as long as screen is touched. Lift off of screen to 
select highlighted item.

- Best for users who:
- can handle timing and attention demands of 

watching and waiting for an item to be 
highlighted

- can keep contact with screen
- can lift off screen reliably in a narrow time 

window

1 Yes No

Step Scanning
- Hit Stepper switch to advance highlight. Hit Picker 

switch to select highlighted item.
- Best for users who:

- have at least two reliable ways to hit a switch 
or the screen. Use the most reliable ways as 
the Stepper - the user will hit it most often.

- may have difficulty with timing and attention 
demands of watching and waiting for an item 
to be highlighted, due to motor issues, 
distractibility, or being new to the idea of 
scanning

2 Yes Yes
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Scanning Mode Number of 
Switches

Can Use 
Screen as 

Switch

Can Use 
External 
Switch

Automatic Step Scanning
- Highlight advances automatically while screen is 

touched. To select highlighted item, lift off of 
screen and then hit Picker switch.

- Best for users who:
- can keep touching the screen more easily than 

they can repeatedly hit the screen or a switch 
as a Stepper

- can handle some of the timing and attention 
demands of watching and waiting for an item 
to be highlighted, but may need practice 
developing this skill

2 Yes No

Scan Patterns

The Scan pattern is the order in which items and groups of 
items are offered for selection.

The Row/Column option is the most commonly used pattern. 
This pattern will first highlight large areas of the screen, and 
then highlight groups of items within the selected area. For 
example, Proloquo2Go will first highlight the message 
window area, then the entire button grid, and last the toolbar 
area. If user activates the switch when the button grid is 
highlighted, rows in the grid will be highlighted one at a time. 
When a row is selected, buttons in that row will be 
highlighted one at a time until an individual button is 
selected.

Select the Linear pattern to have items highlighted one by 
one rather than in groups. This pattern will highlight each 
item in the message window area, then each button in the 
grid, and finally, each button in the toolbar, all one at a time.

The Linear (Grid only) is a combination of the Row/Column 
and Linear patterns. The message window area, grid area, 
and toolbar area are scanned as groups, just as in the Row/
Column pattern. If the grid area is selected, each button is 
scanned one by one, rather than by scanning by row first.

Depending on the scanning mode that you have chosen, you may have two different sets of 
options: one set is for the modes that can be used with one switch, and the other one is for 
two-switch modes.
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One Switch options

These options set up Automatic Scanning, Automatic 
Selecting and Inverse Scanning modes, which employ a 
single external switch or a single active area on the screen.

Adjust the time for which each item is highlighted by 
changing the Scan Rate value. You can use the plus and 
minus buttons, or tap the number directly to pull up a 
keyboard to type a number.

Tap the Screen row to define which part of the screen will 
act as a switch. This can be either the whole screen or its 
left, right, top, or bottom half.

Tap External to configure an external switch. These settings 
are described below.

Advanced options are common to all modes and are 
discussed later in this chapter.

Two Switch options

These options set up Step Scanning and Automatic Step 
Scanning modes, which employ two external switches, two 
active areas on the screen, or a combination of these.

Tap the Screen row in either Stepper Switch or Picker 
Switch group to define which part of the screen will accept 
touches and serve as the corresponding switch.

Tap the External row in Stepper Switch and Picker Switch 
groups to configure an external switch.
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External Switch

Switches are usually attached to a box called a switch 
interface. This interface is connected to the iOS device 
using a wireless system called Bluetooth. See the 
documentation that came with your Bluetooth switch 
interface for information on how to connect the interface with 
your device.

When a switch attached to the switch interface is hit, the 
switch interface will send a special character to the iOS 
device the switch interface is connected to. Proloquo2Go 
will listen for the special character to tell that the switch has 
been hit. The manufacturer of your switch interface decides 
which character(s) the interface will send for each switch 
attached to it. See your switch interfaceʼs documentation to 
find out which character will be sent to Proloquo2Go when 
your switch is activated. Then choose that character from 
the list in the External Switch configuration screen. 
Proloquo2Go supports all Bluetooth switch interfaces 
available at the time it was released. If you canʼt find your 
switch interfaceʼs characters in the External Switch 
configuration list, contact support@assistiveware.com for 
help.
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Advanced options

Auto Restart: Turn Auto Restart Scan on to automatically 
restart scanning after a user selects a button. If Auto Restart 
is turned off, the user will need to activate the switch to 
restart the scanning process.

Delay After Hit: Some users need extra time after they hit 
their switch before they are able to hit it again. This means 
that it can be difficult for these users to get ready in time to 
select the first item that is scanned after they hit their switch. 
Delay After Hit will allow extra time for the first item scanned 
after a switch is hit. The extra time is specified as a 
percentage of the scan rate. If Delay After Hit is 200%, that 
means there is twice as much time given for the first item 
after a switch hit as for other items. If Delay After Hit is 
100%, there is no extra time given.

Visual Cue: Tap the Visual Cue row to change the color and 
width of the border that appears around the highlighted 
object on the screen.

Looping: Users may not be able to “hit” the item they want in 
time the first time a group is scanned. To allow the user 
multiple chances to select the item without having to scan 
back to the group the item is in, turn on the Looping option 
The number in Loops will specify the number of times the 
scan will repeat the current group. The After Looping option 
specifies what happens if nothing is selected after the scan 
has looped through the maximum number of times. You can 
choose between restarting the scan at the top level of the 
scan pattern hierarchy, restarting up one level in the scan 
hierarchy, or stopping the scan 

Debouncing: This option sets a time period after a 
successful switch hit has occurred,during which switch hits 
are ignored. This option is useful for people who have 
trouble moving away from the switch after activating it, 
resulting in unintended switch hits.

Hold Duration: This option specifies how long a switch 
activation has to last before it is registered as a switch hit. 
This is useful for people who have frequent accidental 
switch hits in the process of getting near enough to the 
switch to activate it. Hold Duration is only available when the 
device screen is serving as a switch.

Direction: This option allows speakers of right-to-left 
languages to reverse the direction of scanning.
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11.3. Using Switch Access

After you have turned the switch access on in Options and 
returned to the main app screen, scanning is active but 
paused. You can tell that by the blue scanning indicator  
that appears at the top left corner of the deviceʼs screen.

Q: Can I turn scanning off without going into Options?

Touch and hold the indicator. A message that offers to turn 
the scanning off will appear.

After you tap the blue scanning indicator, scanning starts 
and the indicator changes its appearance .

If you are using the whole screen as one switch, you will see 
a thin red line  around the edge of the screen.

Q: When scanning is active and Iʼm using the screen as a 
switch, how can I get into Options?

To pause scanning, touch the blue scanning indicator. You 
will now be able to touch the Options button to open 
Options.
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In the following example, Automatic Scanning mode and 
Row/Column scanning pattern are selected, and the whole 
screen is being used as the switch. Proloquo2Go starts 
scanning items when the screen is touched. The currently 
highlighted item is marked with a border . 

Q: Can the appearance of the border be changed?

The border can be modified in Scanning > Advanced > 
Visual Cue.

If the screen is tapped when the button grid area is 
highlighted, and Row/Column scanning pattern was chosen, 
each row of the grid will be highlighted in turn.

If the screen is tapped when the second row is highlighted, 
then each button in the second row will be highlighted one at 
a time.
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If the screen is tapped when a verb or noun button is 
highlighted, and Grammar Support is turned on, the normal 
grammar popup will appear and will be scanned in Row/
Column pattern.

Finally, the user can tap the screen to select the word 
“wants.”
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If you select different scanning settings, your deviceʼs screen will also look different, and you 
will need to use other techniques to scan and activate buttons.

Screen shots below show the deviceʼs screen when it is in Step Scanning mode and the 
screen is being used for both switches. In the first screen shot, tapping the green-bordered 
area on the left works as a stepper switch and highlights next item. Tapping the red-bordered 
area on the right works as a picker switch and activates the highlighted item. This is true for 
the second screen shot as well. The difference is that the screen in that screen shot is split 
in two areas horizontally, so the top half of the screen is the stepper and the bottom half is 
the picker.
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12.Frequently Asked Questions
For a full list, please see: http://www.assistiveware.com/support/faq 

How do I pronounce Proloquo2Go?

"Pro" as in professional. “lo” as in low to the ground. “quo” as in quotation. The number “2” 
and “Go” as in on the go. Proloquo2Go. Proloquo is Latin for “speak out loud”.

How do I backup my Proloquo2Go vocabulary?

See chapter 8 as well as our videos here http://www.assistiveware.com/product/
proloquo2go/videos

What devices does Proloquo2Go run on?

Proloquo2Go version 2.0–2.2 runs on all iPod touch, iPhone and iPad devices that can run 
iOS 4.2.1 or later. Proloquo2Go version 2.3 and later, including version 3.0, runs on all iPod 
touch, iPhone and iPad devices that can run iOS 5.1 or later.

Can I use digital pictures?

Yes. All iOS devices that have built-in cameras allow you to take pictures from inside 
Proloquo2Go. With devices that don't have built-in cameras, you first need to take pictures 
with a digital camera, synchronize those to your computer and then using iTunes 
synchronize your computer image library with your device. When you create a new button or 
edit an existing button you can choose a picture from your photo library (all devices) or take 
a picture (devices with cameras). See chapter 4 for details.

Where can I try Proloquo2Go out?

There is a growing number of resource centers (see http://www.assistiveware.com/resource-
centers) that have iPods or iPhones with Proloquo2Go either as loan units or include it as an 
option to explore in their evaluation procedure. These centers can help you decide what the 
right solution is for you.

How can Proloquo2Go be both powerful and affordable?

In many ways Proloquo2Go is at least as powerful as solutions like it, so how can we do 
this? AssistiveWare is committed to making speech generating technology affordable, while 
at the same time making it extremely powerful. These seemingly contradictory goals can 
only be met by: 

• Developing the software for a consumer device instead of a dedicated device; 

• Harnessing the power of one of the most powerful portable hardware platforms available 
today; 

• Utilizing the innovative App Store to distribute the software without requiring a large 
network of sales reps; 

• By making the software as easy to use as an iPhone, iPod touch, or iPad; 

• By providing a lot of online resources and email-based support instead of making house 
calls and providing phone support.
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How can I make printed materials?

You can create screenshots and then print those images from a computer. 

To take a screenshot on an iPhone, iPod touch or iPad

Simultaneously press and then release the Home and Power buttons. The screen will flash 
white and if your sound is on you'll hear a shutter sound confirming that a screenshot has 
been taken. 

Emailing the screenshot from an iPhone, iPod touch or iPad

1) Press the Home button and then tap "Photos" application. 

2) Tap the album titled "Saved Photos" on the iPod touch or "Camera Roll" on the iPhone.

3) Tap the images of the new screenshots.

4) Tap the icon at the bottom left of the screen. A menu appears. 

5) Tap the menu button that says "Email Photo" to launch the Mail app and send the 
screenshot as an attachment. 

6) In the "To" field, enter your email address. 

7) (Optional) Type a subject for your email. 

8) When you are finished, tap "Send". Once the message is sent, check your email on your 
computer. You can now edit and print the screenshots using your favorite photo editing 
software. 

Syncing and printing screenshots from a Mac

1) Connect your iPhone/ iPod touch to your computer. 

2) iPhoto opens with a display of the photos on your iPhone/iPod touch/iPad. In iPhoto, if 
you want to import only some of your photos, select each photo you want to import by 
Command-clicking on each thumbnail, or click and drag to select a set of photos. Next, click 
"Import Selected". 

If you want to download all of your images, click "Import All". 

3) A dialog box appears. Click either "Keep Originals" to download the images you have 
taken while leaving the originals on your iPhone/iPod touch/iPad, or "Delete Originals" to 
download the images you have taken while removing the originals off your iPhone/iPod 
touch.

4) You can now edit and print the screenshots from iPhoto or using your favorite photo 
editing software. 

Syncing and printing screenshots from Windows XP

XP will treat the iPhone like a digital camera device. Therefore, any computer program that 
will sync to and from digital cameras to a windows box can be used to move the pictures 
over.
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If you do not have a program that transfers pictures from digital cameras, you can use 
windowʼs Scanner and Camera Wizard.

1) Connect your iPhone/iPod touch to your computer. 

2) Click "Start".

3) Click "All Programs".

4) Select "Accessories".

5) Select "Scanner and Camera Wizard".

6) Select the iPhone out of your potential devices.

7) If you want to be able to manually copy images over in an explorer-like interface, click the 
"advanced users only" link. If you want to copy images over in a little wizard-like interface, 
click "Next".

You can now edit and print the screenshots using your favorite photo editing software.

How can I download additional voices?

Additional voices can be downloaded when connected to the internet. To download them, go 
to Options View (see section 3.1). Next, tap "Speech", tap "Voice", and then, in the 
Downloadable Voices section, tap the down arrow in the row of the voice you would like to 
download. Voices that have been downloaded are displayed under Installed Voices in the 
Voices View. To switch to a newly downloaded voice, go back to Speech View, select 
"Voice", and choose the voice you want. See chapter 3 for details.

If you want to download the voices but don't have access to WiFi, we suggest that you visit a 
friend, family member, school, or workplace that has a WiFi connection, or use a public 
wireless network as offered in many cafés, libraries, hotels and other places. Any WiFi 
location that you can access for approximately 10-30 minutes (depending on network speed 
and the size of the voice you want to download) should allow you to download the voices. 

At present, we have additional American English female and male voices, two British male 
voices, two British female voices, one Australian male voice, and one Indian female voice 
are available for download. In addition, we have American and British “character” voices 
available.

How can I remove a downloaded voice?

Go to Speech View (see section 3.1). Next, be sure you choose another Voice in the Options 
view as the currently used voice can never be removed. Now, you go to Voice Manager (also 
in the Speech view) and tap the Edit button. You will now be able to delete the downloaded 
voice. Default voices that ship with Proloquo2Go cannot be deleted.

Why does changing the number of columns in Options not affect all folders?

If you go to the Appearance Options and change the number of columns there will be some 
folders in which the number of columns does not change. This happens when a folder was 
designed for a specific number of columns. Examples of such folders are the Home folders 
of the Basic Communication and Core Word vocabularies. Those were designed and 
optimized in terms of layout for specific numbers of columns. So if you set the number of 
columns in Options to 2, the Basic Communication home page will show a 3 column layout. 
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This is the smallest number of columns for which it has been designed (we currently offer 
optimized layouts from 3 column to 6 column for Basic Communication). Similarly if you set 
the number of columns in Options to 10 columns, the Core Word home page will show an 8 
column layout as that is the largest number of columns for which and optimal layout was 
designed (we currently offer optimized layouts from 3 column to 8 column for Core Word). 
For more information see chapter 5.

Further questions

If you have further questions, please go to: http://www.assistiveware.com/support
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Appendix A Environmental Inventory
When customizing a userʼs vocabulary, it is important to include personal information that 
the user may want to communicate about. Use this list to guide conversations with the user 
and his or her family, friends, care providers, school or work staff, and any other people 
important in the userʼs life.

Personal Information:

Full name:

Address:

Phone number:

Parent(s) or guardian names:

Parent(s) or guardian address:

Parent(s) or guardian phone number(s):

Birthday (including year):

Name of school or work place:

Job title, if employed:

Work history:

Medical condition(s) the user may need to communicate about:

People: 

Family (include name and relationship):

Pets (include breed):

Friends/Acquaintances:

Care providers:

School staff:

Work staff:

Medical and therapy care providers:

Public figures the user may want to discuss (musicians, actors, politicians, etc):

Places:

Places at home (rooms or locations within the home that user might need to refer to):
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Places at school or work (rooms or locations within the school or workplace that user might 
need to refer to):

Transportation modes (bus, van, car, etc.):

Stores:

Restaurants:

Other public places (parks, theaters, buildings, offices):

Food and drink:

Favorite foods:

Least favorite foods:

Favorite drinks:

Least favorite drinks:

Food-related information (allergies, food texture restrictions, feeding needs):

Entertainment:

Favorite leisure activities:

Favorite music:

Favorite books/magazines:

Favorite TV shows/movies:

Favorite fictional characters:

Favorite sports, teams, players:

Adaptive Equipment and Assistive Technology:

Mobility equipment (e.g. walker, wheelchair):

Positioning equipment (e.g. stander, bolster, AFOs, splints, TLSO):

Assistive equipment (e.g. glasses, hearing aid):

Access equipment (e.g. joystick, head mouse, pointer, computer access software):

Communication equipment (e.g. communication book, AAC device, iPad, iPod):
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Appendix B Core Word Main Page Vocabulary Lists

3 Columns

Words:
Pronouns:
$ I
$ you
Verbs:
$ want
$ go
Adjectives:
$ more
$ all done
$ not

Folders:
$ Help

4 Columns

Words:
Pronouns:
$ I
$ you
$ it
Verbs:
$ want
$ go
$ do
Adjectives:
$ more
$ all done
$ not
Questions:
$ what

Folders:
! Chat
$ Places
$ People
$ Things
$ Actions

5 Columns

Words:
Pronouns:
$ I
$ you
$ it
Verbs:
$ want
$ go
$ do
$ is
$ like
$ stop
Adjectives:
$ more
$ all done
$ not
$ bad
Questions:
$ what
Prepositions:
$ on
$ off

Folders:
! People
$ Little Words
$ Chat
$ Describe
$ Things
$ Actions
$ Places
$ Help
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6 Columns:

Words:
Pronouns:
$ I
$ you
$ it
$ that
Verbs:
$ want
$ go
$ do
$ is
$ like
$ stop
$ have
$ see
$ get
$ help
Adjectives:
$ more
$ all done
$ not
$ bad
$ good
Questions:
$ what
$ where
Prepositions:
$ on
$ off
$ up
$ down

Folders:
! People
$ Actions
$ Little Words
$ Chat
$ Describe
$ Things
$ Food
$ Fun
$ Places
$ Help

7 Columns:

Words:
Pronouns:
$ I
$ you
$ it
$ that
$ this
Verbs:
$ is
$ do
$ can
$ want
$ have
$ like
$ get
$ see
$ stop
$ go
$ come
$ eat
$ play
$ help
$ make
Adjectives:
$ more
$ all done
$ not
$ bad
$ good
$ some
Questions:
$ what
$ where
Prepositions:
$ on
$ off
$ in
$ out
$ here
$ there
$ up
$ down

Folders:
! People
$ Little Words
$ Fun
$ Chat
$ Help
$ Feelings
$ Things
$ Actions
$ Places

$ Food
$ Time
$ Describe
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8 Columns:

Words:
Pronouns:
$ I
$ you
$ it
$ that
$ this
Verbs:
$ is
$ do
$ have
$ can
$ want
$ need
$ like
$ get
$ put
$ stop
$ go
$ come
$ eat
$ play
$ take
$ see
$ make
$ help
Adjectives:
$ more
$ all done
$ not
$ bad
$ good
$ all
$ some
$ something different
Questions:
$ what
$ where
$ who
Prepositions:
$ on
$ off
$ in
$ out
$ here
$ there
$ up
$ down
$ now
$ to
$ for
$ of

Conjunctions:
$ and
$ but
$ because
Articles:
$ the
$ a

Folders:
! Time
$ Fun
$ Chat
$ Help
$ Feelings
$ People
$ Actions
$ Places
$ Things
$ Food
$ Little Words
$ Describe
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The following are screenshots of Core Word 8x8, 7x7, 6x6, 5x5, and 4x4, using the 
progressive hiding method described in the chapter Progressing Through Core Words. In 
these screenshots, Proloquo2Go was configured to use the “target number” of columns (the 
number of columns that produces buttons that are the smallest size the user can access). 
Then, all buttons that were not in the 3x3 Core Word layout were hidden (producing the 
screenshot labeled “Core Word 3x3 in 8x8”). In the next screenshot, labeled “Core Word 4x4 
in 8x8, the buttons that didnʼt appear in the 3x3 Core Word layout, but do appear in the 4x4 
layout are unhidden (set to Normal visibility). In successive screenshots, this continues for 
5x5, 6x6, and 7x7. 

Note that in these screenshots, the folders that are visible in the “target number” 
configuration are left visible and on the primary level of the home page. This makes the 
fringe vocabulary clearly visible to the user. You may choose to handle the folders differently. 
You demote some or all of the folders to secondary or storage, and/or make the folders 
hidden, so they cannot be accessed, but can quickly be unhidden if needed during a 
particular activity. 

Core Word 3x3 in 8x8 Core Word 4x4 in 8x8
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Core Word 5x5 in 8x8 Core Word 6x6 in 8x8

Core Word 7x7 in 8x8
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Core Word 3x3 in 7x7 Core Word 4x4 in 7x7

Core 5x5 in 7x7 Core 6x6 in 7x7
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Core Word 3x3 in 6x6 Core 4x4 in 6x6

Core Word 5x5 in 6x6
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